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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Security information 1
 

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions constitute one element of such a concept. 

Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected 
to an enterprise network or the internet if and to the extent such a connection is necessary 
and only when appropriate security measures (e.g. firewalls and/or network segmentation) 
are in place.  

For additional information on industrial security measures that may be implemented, please 
visit (https://www.siemens.com/industrialsecurity). 

Siemens' products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends that product updates are applied as soon as they are 
available and that the latest product versions are used. Use of product versions that are no 
longer supported, and failure to apply the latest updates may increase customers' exposure to 
cyber threats.  

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed visit (https://www.siemens.com/industrialsecurity). 

https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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S7-PLCSIM overview 2
2.1 Introduction to S7-PLCSIM 

S7-PLCSIM supports debugging and validating a single PLC program without requiring actual 
hardware. S7-PLCSIM allows you to use all STEP 7 debugging tools, including the watch table, 
program status, online & diagnostics functions, and other tools. 

S7-PLCSIM also provides tools that are unique to S7-PLCSIM, including a SIM table, sequence 
editor, events editor, and scan control.  

S7-PLCSIM operates in conjunction with STEP 7 programming in the TIA Portal. You use 
STEP 7 to perform the following tasks: 

1. Configure your PLC and any associated modules in STEP 7

2. Program your application logic

3. Download the hardware configuration and program to S7-PLCSIM in either Compact view or
Project view

2.2 What's new in S7-PLCSIM V17? 
S7-PLCSIM V17 introduces the following new or updated functionality: 

• Support of the latest hardware and firmware (Page 11) including the following:

– S7-1504D TF and S7-1507D TF Drive controllers

– S7-1500R/H Redundant controllers

– S7-1518 T/TF

– SIMATIC S7 SIPLUS CPUs

– SIMATIC ET 200pro

• Improved performance

• Removal of device configuration view: Device view is available in the TIA Portal.

You can install additional user interface languages for S7-PLCSIM from the TIA Administrator 
and TIA Updater Corporate Configuration Tool. For information, refer to the "What's new in 
TIA Portal V17 > Installing language packs" topic in the TIA Portal Information System. 

2.3 A note about input values 
Input values from the S7-PLCSIM SIM table editor and sequence editor in Project view are 
equivalent to the peripheral inputs on a physical CPU. These are the values that are copied to 
the process image at the start of each scan cycle. 
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In STEP 7, you cannot modify peripheral input values. S7-PLCSIM allows you to assign inputs 
in SIM tables and sequence tables. This feature allows you to simulate program behavior with 
different input values. 

2.4 Installation notes and requirements 
Installing TIA Portal does not install S7-PLCSIM. Installing S7-PLCSIM V17 also installs 
S7-PLCSIM V5.4.8 incl. Update 1 for simulation of S7-300 and S7-400 CPUs. 

You can install multiple versions of S7-PLCSIM on the same computer without interference. 

Supported operating systems 
S7-PLCSIM V17 supports the same set of operating systems as TIA Portal V17. Refer to the 
TIA Portal online help readme for a definitive list of supported operating systems. 

If you have already installed TIA Portal V17 successfully, you can install S7-PLCSIM V17. 

Hibernation mode and power saving settings 
Hibernation mode or sleep mode can disrupt communication connections between STEP 7 
and S7-PLCSIM. Potentially, you could lose unsaved work. 

To prevent such problems, apply these Windows operating system settings: 

• Disable hibernation mode.

• Set the power saving options to never put the computer to sleep. This setting ensures that
a timer does not automatically trigger hibernation.

• Do not trigger hibernation when using S7-PLCSIM.

Hardware requirements 
Your programming device must meet the hardware and software requirements of 
TIA Portal V17.   

For acceptable performance, use a programming device with a quad core processor that is 
equal to, or better than, an Intel® Core™ i5-6440EQ 3.40 GHz. 

Refer to the Installation section of the TIA Portal V17 online help for specific details. 

S7-PLCSIM Advanced 
S7-PLCSIM Advanced is a product that provides advanced simulation capabilities. You can 
install S7-PLCSIM and S7-PLCSIM Advanced on the same machine. You cannot run both 
S7-PLCSIM and S7-PLCSIM Advanced at the same time.  
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2.5 Supported hardware 

2.5.1 Hardware and firmware support 
Your STEP 7 license determines which CPUs you can simulate with S7-PLCSIM. 

STEP 7 Basic and S7-PLCSIM 
With a STEP 7 Basic license, you can simulate the following CPU families in S7-PLCSIM: 

• S7-1200 with firmware version 4.0 through version 4.5 

• S7-1200F with firmware version 4.1 through version 4.5 

If your project contains CPUs with older firmware versions, the "Start simulation" button in 
the TIA Portal is not selectable and you cannot start a simulation. 

You can start and run two S7-1200 or S7-1200F simulations at the same time with any 
combination from these two CPU families. 

STEP 7 Professional and S7-PLCSIM 
With a STEP 7 Professional license, you can simulate any of the following CPU families: 

• S7-1200 with firmware version 4.0 through version 4.5 

• S7-1200F with firmware version 4.1 through version 4.5 

• S7-1500 and S7-1500F with any firmware version up to version 2.9 

• S7-1504D TF and S7-1507D TF with firmware version 2.9 

• S7-1500R/H with firmware version 2.9, RUN Solo mode 

• ET 200SP and ET 200SPF with any firmware version up to version 2.9 

• S7-1518 T/TF 

• S7-1500 1518-HF-4 PN 

You can start and run two simulations at the same time with any combination of these CPUs. 

SIPLUS CPUs 
S7-PLCSIM supports the SIPLUS variants of the supported CPUs. 

2.5.2 Hardware with upgraded firmware 
S7-PLCSIM cannot simulate CPUs with a newer firmware version than the highest supported 
version at the time of the S7-PLCSIM release (Page 11). 

You can only download the hardware configuration from STEP 7 if S7-PLCSIM is compatible 
with the firmware version of the hardware. For example, if you have installed or updated a 
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device's firmware in STEP 7 using a hardware support package (HSP), you might not be able 
to download to S7-PLCSIM. 

2.6 S7-PLCSIM documentation 

2.6.1 Online help system 
A comprehensive online help system describes the features and procedures you need to work 
more effectively with S7-PLCSIM and STEP 7. The online help system opens in a separate 
window from the S7-PLCSIM user interface so that you can continue to work while you obtain 
the information you need.  

You can launch the online help in the following ways: 

• Select the Help > Show help menu command. 

• Click the F1 key anywhere in the application. 

The online help system includes help for both S7-PLCSIM and the TIA Portal under the 
"Content" tab: 

• The S7-PLCSIM help is designated as "S7-PLCSIM V17 online help". 

• The TIA Portal help is designated as "Information System". 

 

 Note 
TIA Portal Information System 

The TIA Portal Information System that is included with S7-PLCSIM is a subset of the complete 
TIA Portal Information System. The chapters and topics are those most relevant to S7-PLCSIM. 
For the complete TIA Portal Information System, access the help from the TIA Portal Help 
menu. 

 

Intended audience 
The help documentation is intended for personnel with knowledge and experience in the 
following technologies:  

• Industrial automation and automation engineering 

• PLC programming 

• SIMATIC PLCs 

• STEP 7 

Searching the online help 
When you search for information, results might show matching topics from both the 
S7-PLCSIM help and the TIA Portal help. 
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As an example, search on the term "display format" in the "Search for:" box on the left-hand 
side of the information system. The results of the search will contain both S7-PLCSIM and 
TIA Portal topics. 

If you want to view only the S7-PLCSIM help search results, sort on the "Position" column 
header and the S7-PLCSIM help search results are grouped together. In this way you can be 
sure you are seeing all of the S7-PLCSIM search results. This makes it easier for you to 
determine which S7-PLCSIM help topic will address your display format question in the way 
that is most useful to you. 

Online help available in electronic format 
The online help is also available in PDF and HTML5 format from the Siemens Industry Online 
Support (https://support.industry.siemens.com/cs/us/en/view/109761511) Web site. In 
addition to the S7-PLCSIM online help you can find additional information at this Web site: 

• News about the latest information on your products 

• Documentation for your products 

• Forums for worldwide knowledge exchange between users and experts 

• Your local contact for Siemens Industry products and services 

• Information about on-site services, repairs, spare parts, and much more 

2.6.2 Readme file 
The S7-PLCSIM readme file provides additional information about S7-PLCSIM. 

S7-PLCSIM readme file 
The readme file is available at the time you install S7-PLCSIM. 

You can access the readme file during installation by clicking the "Read product information" 
button.  

You can access the readme file after installation from the Help folder in your installation 
location. 

S7-PLCSIM installs one readme file for each language: 
 
Language File name 
Chinese (simplified) ReadMePE2MzhCN.chm 
English ReadMePE2MenUS.chm 
German ReadMePE2MdeDE.chm 

Updates to the readme are posted online 
The readme file is updated as needed. Updates are posted online in each language in PDF 
format.  

https://support.industry.siemens.com/cs/us/en/view/109761511


S7-PLCSIM overview  
2.6 S7-PLCSIM documentation 

 S7-PLCSIM V17 online help 

14 Programming and Operating Manual, V17, 05/2021, A5E46238743-AB 

If you encounter unexpected behavior in S7-PLCSIM, consult the online version of the readme 
file to see if there is a topic that addresses your issue. Visit the Siemens Industry Online 
Support website (https://support.industry.siemens.com/cs/?lc=en-US) and search for 
"S7-PLCSIM V17 readme". 

https://support.industry.siemens.com/cs/?lc=en-US
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 S7-PLCSIM concepts 3 
3.1 Two views: Compact view and Project view 

With S7-PLCSIM, you can choose between two different user interfaces: Compact view and 
Project view. The view you select will depend on how you want to use S7-PLCSIM in 
conjunction with TIA Portal. 

Compact view 
Compact view (Page 30) consists of one small window with a limited number of controls and 
functionality.  

This view will be useful to you if you want to debug your program in STEP 7 rather than in the 
S7-PLCSIM Project view. 

S7-PLCSIM launches in Compact view by default. If you want to make Project view the default 
view, you can make this change in the Project view main menu under Options > Settings. 

Project view 
Project view (Page 32) contains the full functionality of S7-PLCSIM. Project view has the same 
look and feel as the user interface of the TIA Portal.  

Project view consists of several components: 

• Main menu and main toolbar 

• Options and settings (accessed from the main menu) 

• Project tree 

• SIM table editor 

• Sequence editor 

• Events editor 

• Online tools, including the operator panel and scan control settings 

Project view is useful to you if you prefer to debug your program using the full functionality 
of S7-PLCSIM. 

Switching between Compact view and Project view 
Regardless of which view you selected as the default, you can easily switch between Compact 
view and Project view by clicking the switch views  button.  
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3.2 Starting and ending a simulation 
Both Compact view (Page 30) and Project view (Page 32) have a power button  for starting 
and ending a simulation. 

Starting and ending simulations are separate tasks from creating or opening S7-PLCSIM 
projects (Page 44). 

Starting a simulation 
To start a new simulation, select your desired CPU family from the drop-down list (Page 27) 
and then click the power button to launch the simulation. The power button is green when 
your simulation is running.  

Ending a simulation 
You can end an active simulation by clicking the power button again.  

You can end a simulation regardless of whether there is an open S7-PLCSIM project. If there is 
an open project and you are in Project view, the project tree shows this state. 

In Compact view, the power button is gray and the CPU family selector is selectable when you 
have ended a simulation. 

Ending a simulation can be useful in the following cases: 

• Simulating a power cycle (Page 26) 

• Changing the CPU family (Page 27) 

Power cycling the CPU 
When you end a simulation, S7-PLCSIM saves your configuration. When you click the power 
button again, the new simulation starts with the same configuration it had when you ended 
it. This has the effect of power cycling the simulated CPU. 

Changing the CPU family 
You must end the active simulation to change the CPU family you are simulating (Page 27).  

3.3 Simulation states 
S7-PLCSIM recognizes the following types of PLC simulation: 

• Unconfigured PLC (powered on, but no downloaded STEP 7 project) 

• Configured PLC (powered on, with a downloaded STEP 7 project) 

• No simulation (powered off) 
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Unconfigured PLC 
The simulated PLC is unconfigured if you have started a simulation for a PLC from STEP 7 but 
have not yet performed a project download from STEP 7. The simulated CPU is powered on. 

In this state, S7-PLCSIM displays the PLC name as "Unconfigured PLC". 

Configured PLC simulation 
S7-PLCSIM simulates a configured PLC after you have downloaded a specific PLC from STEP 7. 
In this case, S7-PLCSIM displays the PLC name and CPU type, for example, 
"PLC_1 [CPU 1215 DC/DC/DC]". The simulated CPU is powered on. 

No simulation 
S7-PLCSIM is in the "no simulation" state when the simulated PLC is powered off. The power 
button is gray, or disabled, in this state.  

If you are in the "no simulation" state, you can still create an S7-PLCSIM project and set up 
your SIM tables and sequences in Project view. If you start S7-PLCSIM from the Windows 
desktop or Start menu (Page 23), it has no simulation. 

3.4 Supported STEP 7 programs for simulation 
S7-PLCSIM accepts the download of any valid program for a supported, configured CPU. With 
some exceptions, the downloaded program can go to RUN mode without changes.  

In the following cases, consider these changes to your STEP 7 program before downloading 
the program to S7-PLCSIM: 

• Fail-safe programs. S7-PLCSIM supports fail-safe program simulation. You might, 
however, need to increase the F-cycle time because scan times for the simulation will be 
longer. 

• Motion control programs. To successfully simulate motion control programs, you might 
need to increase the motion cycle time because scan times for the simulation will be 
longer. 

Your STEP 7 configuration might support newer hardware than S7-PLCSIM recognizes 
(Page 11). If you have installed devices with an HSP (hardware support package), S7-PLCSIM 
might not be able to simulate those devices.. 

3.5 Differences between a simulated PLC and a physical PLC 

3.5.1 Differences common to all supported PLCs 
S7-PLCSIM differs from physical PLCs in the following areas. 
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I/O device support 
S7-PLCSIM does not support specialized I/O device functionality. It provides only process 
image and direct access simulation of I/O registers.  

You can observe this specialized functionality with, for example, analog output range 
monitoring. On a physical device, if the STEP 7 program writes an out-of-range value to an 
analog output register, the analog module returns a diagnostic error. This does not occur in 
S7-PLCSIM.  

Open and software controllers 
S7-PLCSIM V17 does not support simulation of software and open controllers. 

Diagnostics 
S7-PLCSIM does not support all of the error messages written to the diagnostic buffer. For 
example, S7-PLCSIM does not simulate messages about bad batteries in the CPU, or EPROM 
errors. However, S7-PLCSIM simulates most program errors.  

Time-based performance 
Because S7-PLCSIM is software running on a programming device under the Windows 
operating system, the scan cycle time and the exact time of actions in S7-PLCSIM is not the 
same as if PLC firmware performed those actions.  

If your program is highly dependent on the time that actions execute, do not evaluate your 
program based only on the time results of your S7-PLCSIM simulation. 

Access and copy protection 
S7-PLCSIM does not simulate access protection or copy protection.  

Flashing LEDs 
STEP 7 and other tools can only flash LEDs on physical PLCs. You cannot flash the LEDs in 
either view of S7-PLCSIM from STEP 7 or any other tool. 

Features that require an SD memory card 
S7-PLCSIM does not simulate CPU functionality that requires an SD memory card. 

Recipes 
S7-PLCSIM does not support recipes.  

Web server 
S7-PLCSIM does not support Web server functionality.  
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PROFIBUS 
If your STEP 7 project contains PROFIBUS elements, S7-PLCSIM will not simulate the PROFIBUS 
elements, but the remainder of your project will be simulated as usual. 

You do not need to remove the PROFIBUS elements from your project before starting your 
simulation. Just be aware that S7-PLCSIM ignores the PROFIBUS elements.  

F-CPU simulation 
To simulate an F-CPU, you must adjust the F-parameter F-monitoring time in your STEP 7 
project before you download to S7-PLCSIM. This is due to the difference in timing between a 
software-based simulation and physical hardware. 

To adjust the F-monitoring time, follow these steps: 

1. In the STEP 7 Project tree, right-click your F-CPU and select "Properties". 

2. In the Properties dialog, navigate to "Fail-Safe > F-parameter > Default F-monitoring time for 
central F-I/O". 

3. Adjust the F-monitoring time from the default of 150 ms to a higher value. 

4. Click OK. 

You might need to repeat this procedure until you find an F-monitoring value that allows 
your F-CPU simulation to run without errors. 

Instruction support 
S7-PLCSIM supports most instructions for the simulated S7-1200 and S7-1200F in the same 
way as for a physical PLC. 

You can download all programs that successfully compile to the virtual PLC. However, some 
instructions call SFCs (system functions) or SFBs (system function blocks) that are only 
partially supported, and your simulation might not function as you expect. 

For programs with partially supported instructions, S7-PLCSIM validates input parameters and 
returns outputs that are valid, but not necessarily what a real PLC with physical I/O would 
return. For example, S7-PLCSIM does not support the SIMATIC SD memory card, so program 
instructions that save data on a memory card do not actually save data when a simulation 
executes. 

Timing dependencies 
Programs that are very dependent on timing might be difficult to debug with a simulation 
due to differences in timing between a software-based simulation and physical hardware. 
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3.5.2 S7-1200: Technology module and technology object support 
S7-PLCSIM does not simulate the following technology modules and technology objects: 

• Counting  

• PID 

• Motion control  

3.5.3 S7-1500: Technology module and technology object support 

Technology module support 
S7-PLCSIM supports the following technology modules for the S7-1500 and S7-1500F:  

• Counting and measurement 

• PID 

• Time-based I/O 

• Motion control 

Technology object support 
S7-PLCSIM supports the following technology objects for the S7-1500 and S7-1500F:  

• Counting and measurement 

• PID 

• Motion control 

3.5.4 ET200SP: Technology module and technology object support 

Technology module support 
S7-PLCSIM supports the following technology modules for the ET 200SP and ET 200SPF:  

• Counting and measurement 

• PID 

• Time-based I/O  

• Motion control  
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Technology object support 
S7-PLCSIM supports the following technology objects for the ET 200SP and ET 200SPF:  

• Counting and measurement 

• PID 

• Motion control 

3.5.5 S7-1500R/H: Simulation differences 
You can simulate the S7-1500R/H in RUN-Solo mode only. You can run only one instance of 
S7-PLCSIM for an S7-1500R/H. 
 



 

 S7-PLCSIM V17 online help 

22 Programming and Operating Manual, V17, 05/2021, A5E46238743-AB 

 Startup options 4 
4.1 Overview of startup options 

There are several options for starting S7-PLCSIM: 

• Startup from the TIA Portal 

• Startup from the Windows desktop icon or start menu 

• Startup from an existing S7-PLCSIM project 

Note that you can start multiple instances of S7-PLCSIM and run two concurrent simulations 
(Page 97). 

After you start S7-PLCSIM, you can change your default start view (Page 41). 

Enabling simulation support 
You must enable simulation support for any program you intend to download to S7-PLCSIM. 
If you start the simulation from the TIA Portal, STEP 7 prompts you to enable simulation 
support. If you start simulation by opening S7-PLCSIM or opening a saved simulation project, 
you must enable simulation support from STEP 7. 

To enable simulation support in STEP 7, follow these steps:  

1. Open the project properties. 

2. Select the Protection tab. 

3. Select the check box to support simulation. 

4. Compile the project. 

4.2 Starting a simulation from TIA Portal 
After you have installed S7-PLCSIM, the "Start simulation" command is available in STEP 7 for 
the following devices: 

• S7-1200 

• S7-1500 

• ET 200SP 
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Enabling simulation for know-how protected blocks 
To be able to simulate blocks with know-how protection, follow these steps in STEP 7: 

1. Remove the know-how protection from the protected blocks. You must enter the password 
to remove the know-how protection. 

2. Enable simulation support (Page 22) for the STEP 7 project. 

3. Compile the project. 

Starting a simulation when S7-PLCSIM is not running 
To start S7-PLCSIM from STEP 7, select your CPU in the project tree and choose one of the 
following methods:  

• Click the "Start simulation" button  on the main toolbar. 

• Right-click the device in the project tree and select "Start simulation" from the shortcut 
menu. 

STEP 7 loads the project to S7-PLCSIM. By default, S7-PLCSIM launches in Compact view with 
no open project. 

Downloading from STEP 7 to a running instance of S7-PLCSIM 
If you want to use to an open instance of S7-PLCSIM, download the project from STEP 7 to 
the PLCSIM PG/PC interface. 

4.3 Starting from a desktop icon or start menu 
You can start S7-PLCSIM from the desktop icon or from the Windows start menu. When you 
start from the desktop icon or start menu, S7-PLCSIM launches without an open project. 

4.4 Starting from an existing S7-PLCSIM project 
You can use previously saved S7-PLCSIM projects for simulation. The S7-PLCSIM project 
contains the SIM tables and sequences that you previously created and saved. Your project 
also contains the hardware configuration and software that you downloaded to the 
simulation. S7-PLCSIM restores the configuration to the simulation when you open the 
S7-PLCSIM project. 

There are two ways you can open an existing S7-PLCSIM project: 

• Double-clicking a project file on your programming device 

• Open a project from the S7-PLCSIM main menu or main toolbar in Project view 

When you open a saved project, S7-PLCSIM opens all editors that were open when you saved 
your project. 
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Opening a project from a saved file 
You can open an existing project by double-clicking a *.sim16 project file. In this case, 
S7-PLCSIM launches in Project view, regardless of the application setting for "Start view": 

• The Project view opens and contains the SIM tables, event tables, and sequences for the 
project. 

• If you previously downloaded a STEP 7 project to S7-PLCSIM, S7-PLCSIM goes online with 
the running simulation. 

Opening a project from S7-PLCSIM 
You can open a project in Project view by: 

• Navigating to Main menu > Project > Open project 

• Clicking the "Open project" button on the main toolbar 

 

 Note 

You cannot open a project while you are in Compact view. You must switch to Project view to 
open a project. 

 

4.4.1 Opening a project from a previous version 
You can open an S7-PLCSIM V16 project with S7-PLCSIM V17. When you select the project, 
S7-PLCSIM notifies you that the project must be converted to an S7-PLCSIM V17 project 
(.sim17). Upgrading the project creates a new project folder for the upgraded project. Once 
the upgrade is complete, S7-PLCSIM opens the upgraded .sim17 project. The .sim17 project is 
no longer compatible with S7-PLCSIM V16. 

Versions older than V16 
You cannot open S7-PLCSIM projects from versions older than S7-PLCSIM V16. To open these 
projects with S7-PLCSIM V17, follow this procedure: 

1. Open the project with S7-PLCSIM V16. 

2. Save the project as an S7-PLCSIM V16 project. 

3. Open the .sim16 project with S7-PLCSIM V17. 

4.4.2 Using an existing S7-PLCSIM project for simulation and debugging 
Once you have opened the S7-PLCSIM project, the simulation is active and ready for 
debugging in either S7-PLCSIM or STEP 7. 

If you do not have the STEP 7 project that you previously used to create the simulation, you 
can still use STEP 7 for debugging. Open a new STEP 7 project in the TIA Portal and upload 
the running simulation. You can then go online in STEP 7 with the running simulation.  
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 Modifying an active simulation 5 
5.1 Simulating a power cycle 

The following Compact view shows a running, configured S7-1200 CPU simulation. 

 

Notice the following: 

• The power button is green. 

• The configured CPU name is displayed. 

• The communications (IP) address is shown. 

• The LEDs are active. 

• The RUN, STOP, and MRES buttons are enabled. 

Clicking the power button to turn off the simulation results in the following appearance: 
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Note what has, and has not, changed in the user interface: 

• The power button is gray. 

• The configured CPU name is still displayed. 

• The communications (IP) address is removed. 

• The LEDs are disabled. 

• The RUN, STOP, and MRES buttons are disabled. 

• The CPU family selection is visible. 

The virtual PLC configuration is retained when you stop the simulation. If you click the power 
button again, the new simulation starts with the same configuration. This has the effect of 
power cycling the previous simulation. 

5.2 Changing the CPU family 
You can also change the CPU family for the simulation. Here, the simulation is in Compact 
view in the powered off state: 

 

The drop-down list for the CPU family is visible. Clicking the down arrow displays the list of 
supported CPU families: 
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If you change CPU families and then click the power button, S7-PLCSIM starts a new, 
unconfigured simulation of the family you selected. S7-PLCSIM discards the configuration 
from the previous simulation. If you click S7-1500, for example, the Compact view appears as 
follows: 

 

In an unconfigured simulation, note the following: 

• S7-PLCSIM displays an Unconfigured PLC name of the CPU family you selected. 

• No communications (IP) address is shown. 

• The RUN, STOP, PAUSE, and MRES buttons are disabled. 

• You must download a STEP 7 project to simulate a new CPU. 

Appearance in Project view 
Project view shows an open S7-PLCSIM project if you have created or opened a project. You 
can use the operator panel (Page 38) in Project view to change the simulation family. Starting 
a new simulation causes the Project tree to update to show the new, unconfigured 
simulation. 

5.3 Resetting memory (MRES) 
A memory reset clears all working memory areas and copies load memory to working 
memory.  

Resetting memory 
To reset the memory on a powered-on simulated CPU, click the MRES button. 

S7-PLCSIM performs the following actions during a memory reset:  

• Power cycles the simulated PLC. 

• Breaks the online connection between STEP 7 and S7-PLCSIM, if STEP 7 was online with 
S7-PLCSIM. 
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Result: M memory and Data Block values return to their start values. The simulated PLC is 
powered on. 

You can perform a memory reset at any time regardless of the scan mode (RUN, STOP, HOLD, 
PAUSED, ERROR).  

You can reset memory from either the Compact view or the operator panel (Page 38) in the 
Project view. 
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 Working in Compact view 6 
 

 

Compact view is the default view for S7-PLCSIM and uses less screen space than the Project 
view (Page 32). 

If you prefer to launch in Project view, you can change the default view from the Project view 
main menu under Options > Settings. 

You cannot perform project actions or run sequences in Compact view. You must switch to 
Project view to use these functions. 

When you launch S7-PLCSIM in Compact view, S7-PLCSIM opens with no project and no 
simulation: 

 

Description of the Compact view user interface 
When configured and connected to a CPU, Compact View has the following appearance: 
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Compact view has the following sections: 
 
Section Description 
Title bar The title bar displays the S7-PLCSIM logo and three control 

buttons: 
• "Keep on top" button - Causes Compact view to display 

on top of all other windows 
• Minimize button - Standard Windows functionality 
• Close button - Standard Windows functionality 

CPU name This section of Compact view shows the name and type of 
the virtual PLC. Different text is displayed based on the state 
of the application: 
• "<no simulation>": S7-PLCSIM has no open simulation 
• "Unconfigured": S7-PLCSIM has an unconfigured 

simulation. You have not yet downloaded a project from 
STEP 7 to S7-PLCSIM 

• CPU name and CPU type: S7-PLCSIM has a configured 
simulation. The CPU name and CPU type correspond to 
the STEP 7 project's device configuration. Example: 
"PLC_1 [CPU 1517-3 PN/DP]" 

The CPU name section also contains the "Switch to Project 
view" button. 

CPU control panel The control panel includes the power button and these LEDs: 
• RUN / STOP 
• ERROR 
• MAINT 
Compact view also provides buttons for these functions: 
• RUN 
• STOP 
• PAUSE 
• MRES 
These controls are only operational when S7-PLCSIM has an 
active, configured simulation. This section also displays the 
IP address for each interface of a simulated CPU. 
The Compact View control panel functions are the same as 
the operator panel (Page 38) in the Project View. 

Project name The project name section of Compact view displays the 
name of the S7-PLCSIM project, if a project exists. You do not 
need an S7-PLCSIM project to run a simulation. When you do 
not have an open S7-PLCSIM project, this section displays 
"<no project>". When you have created or opened an 
S7-PLCSIM project, you see the name of your project. 
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 Working in Project view 7 
7.1 Project view user interface 

7.1.1 Project view user interface overview 
Project view provides the full functionality of S7-PLCSIM: 

 
① Title bar Displays the project path and project name, and buttons to switch to Compact view, minimize the 

application, maximize the application, and close S7-PLCSIM.  
② Menu bar  Displays menus for project commands, edit commands, execute commands, options settings, tool 

commands, window commands, and help commands.  
③ Toolbar Provides buttons for project commands, edit commands, execute commands, switching to 

Compact view, splitting the display into horizontal or vertical windows, and recording tool 
commands.  

④ Project tree Displays the project name, SIM tables, sequences, and event tables. 
You can drag the right bar of the Project tree to make it wider or narrower. 
You can collapse the Project tree by clicking "Collapse" or "Collapse automatically" from the top 
right corner of the Project Tree frame. 
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⑤ Editor windows Provides editors for SIM tables, sequences, and event tables. You can display two editors at the 
same time either horizontally or vertically. 
You can resize columns in SIM tables, sequences, and event tables by double-clicking the dividing 
line between columns, or by moving the dividing line left or right. 

⑥ Editor bar and 
status bar with 
progress display 

Displays shortcuts to open editors and the status of the simulated PLC. 

⑦ Operator panel Displays the operator panel for the simulated CPU with operating mode and scan control buttons 
⑧ Scan control Provides configuration settings for scan control 

Managing the workspace 
You can customize your workspace by selecting Options > Setting" from the main menu. 

If you split the screen vertically or horizontally, each pane contains either a "pin" icon  or an 
"unpin" icon . Click the "pin" icon to keep one of the panes constant as you view objects in 
the other pane. For example, if you have several sequences, you can pin one of them to keep 
it visible while you cycle through other sequences in the unpinned pane. Clicking Ctrl+F6 in 
an unpinned pane allows you to cycle between sequences (or any other work area you want 
to view).  

You can float, reposition, and resize editor windows. You can save your layout by clicking the 
"Save window settings" button  in the upper right corner of each editor. 

Switching to Compact view from Project view 
You can switch from Project view to Compact view by clicking the "Switch to Compact view" 
button on the main toolbar. 

7.1.2 The S7-PLCSIM menu bar 
The S7-PLCSIM main menu provides the following functions:  

 
Menu Description 
Project (Page 34) Contains commands for creating new projects; opening existing projects; closing, deleting, and saving 

projects; and exiting S7-PLCSIM. There is also a list of your most recent projects.  
Edit (Page 34) Contains editing commands for the selected object. 
Execute 
(Page 35) 

Switches the simulated PLC to RUN mode or to STOP mode.  

Options 
(Page 35) 

Opens the settings dialog so you can adjust the application settings.  

Tools (Page 36) Contains recording commands 
Window 
(Page 36) 

Allows you to customize the workspace.  

Help (Page 37) Opens the help system, provides a link to the Siemens Industry Online Support website, and shows 
details of the installed software.  

For most menu commands, S7-PLCSIM provides a toolbar button (Page 37) for the function. 
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7.1.2.1 Project menu commands 
The Project commands are as follows: 

 

 
 
Menu text Description 
New Creates a new project (Page 44) and a new simulated PLC. If the current 

project contains unsaved changes, you are asked to save the project. 
Open Allows you to navigate to the project you want to open. If your current 

project contains unsaved changes, you are asked to save the project.  
Close Closes the current simulation project. If the current project contains unsaved 

changes, you are asked to save the project.  
Save Saves the simulation project using the current path and file name. You 

cannot save a project during a download from STEP 7.  
Save as Allows you to save your project with a new name and/or a new path. 

"Save as" is disabled during a download from STEP 7. 
Delete project Allows you to select a project for deletion. 
<List of recent 
projects> 

Allows you to open a project that you have recently saved. If your current 
project contains unsaved changes, you are asked to save the project before 
opening your selected project. 

Exit Closes the simulated PLC and the S7-PLCSIM application. If the current 
project contains unsaved changes, you are asked to save the project. 

7.1.2.2 Edit menu commands 
The Edit functions are as follows:  
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Menu text Description 
Open object This menu item is enabled when an object that can be opened has application 

focus. This is true when the focus is on the Project tree and one of the following 
elements is selected: 
• The simulated PLC 
• A SIM table 
• A sequence 

Undo Undo the last action 
Redo Redo the action that was undone 
Cut Standard clipboard Cut functionality. Cut is enabled or disabled based on your 

current selection. 
Copy Standard clipboard Copy functionality. Copy is enabled or disabled based on your 

current selection. 
Paste Standard clipboard Paste functionality. Paste is enabled or disabled based on your 

current selection. 
Delete Standard Delete functionality. Delete is enabled or disabled based on your current 

selection. 
Rename Allows you to rename the selected object. Rename is enabled when you select 

one of the following Project tree elements: 
• A SIM table 
• A sequence 

Properties Not available 

7.1.2.3 Execute menu commands 
The Execute functions are as follows: 

 

 
 
Menu text Description 
Start CPU  Transitions the simulated PLC to RUN mode. You can click the Start CPU button 

when the simulated PLC is in STOP mode.  
Stop CPU  Transitions the simulated PLC to STOP mode. You can click the Stop CPU button 

when the simulated PLC is in RUN mode. 

7.1.2.4 Options menu commands 
The Options command is as follows:  

 



Working in Project view  
7.1 Project view user interface 

 S7-PLCSIM V17 online help 

36 Programming and Operating Manual, V17, 05/2021, A5E46238743-AB 

 
 
Menu text Description 
Settings 
(Page 40) 

Allows you to make changes to the appearance and behavior of S7-PLCSIM.  

7.1.2.5 Tools menu commands 
The Tools menu commands Record, Stop, and Pause (Page 68) enable you to record a series 
of actions in the SIM table editor and save them in a sequence:  

 

 
 
Menu text Description 
Start recording Starts recording actions in the SIM table editor 
Stop recording Stops recording actions in the SIM table editor and creates a new 

sequence from the recording 
Pause recording Pauses a recording 

7.1.2.6 Window menu commands 
The Window functions allow you to customize the workspace to fit your needs and to switch 
the application to Compact view.  

 

 
 
Menu text Description 
Close all Closes all open editor windows. 
Minimize all Minimizes all open editor windows. The editors are still active and are available 

by using the icons in the editor frame. 
Compact view  Transitions the application to Compact view. The main S7-PLCSIM view 

becomes invisible. 
Next editor Used to switch between open editor windows. The ordering of the open editors 

is the order in which they were opened. "Next editor" is disabled if only one 
editor is open. 
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Menu text Description 
Previous editor Used to switch between open editor windows. The ordering of the open editors 

is the order in which they were opened. "Previous editor" is disabled if only one 
editor is open. 

Split editor space 
vertically  

Creates a vertically split work space so that you can view two editor windows 
concurrently. 

Split editor space 
horizontally 

Creates a horizontally split work space so that you can view two editor 
windows concurrently. 

Unsplit editor space Returns a vertically or horizontally split work space to a single editor window. 

7.1.2.7 Help menu commands 
The Help functions are as follows:  

 

 
 
Menu text Description 
Show help  Opens the help system.  
Service & Support in 
Internet 

Provides a link to the Siemens Industry Online Support website.  

Installed software  Displays information about your installed Siemens software, including 
version numbers for S7-PLCSIM and the TIA Portal. 

7.1.3 S7-PLCSIM toolbar 
The S7-PLCSIM toolbar provides the same functionality as the main menu, and also provides 
power on/power off and CPU family selection functionality:  

 

The toolbar contains the following button groups: 
 
Button group Function 

 
Project commands (Page 34) 

 
Edit commands (Page 34) 

 
Power on or off the simulated CPU. 
When powered off, change the CPU family. 
Both functions are also available on the Operator Panel (Page 38) and in Compact view 
(Page 30). 

 
Operating mode (Execute menu) (Page 35) 
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Button group Function 

 
Undo and redo actions (Page 34) 

 
Recording commands (Tools menu) (Page 36) 
Contains recording commands 

 
Window display and Compact view selection (Page 36) 
Allows you to customize the workspace.  

7.1.4 The Operator panel 
The CPU operator panel contains the following: 

• A button for powering on and powering off the CPU 

• A CPU family drop-down list 

• Status LEDs that enable you to see the operating mode and state of the CPU: RUN/STOP, 
ERROR, or MAINT 

• Buttons that enable you to change the CPU operating mode to RUN or STOP 

• A PAUSE button to pause a scan that is running. 

• An MRES button for resetting memory (Page 28) 

• The CPU IP address or addresses  

Button functions 
You can use the power button to power off the CPU at any time regardless of the scan mode 
(RUN, STOP, HOLD, PAUSE, or ERROR).  

Use the RUN button to place the CPU in RUN when the scan is in STOP or PAUSE mode. 

Use the STOP button to place the CPU in STOP when the scan in RUN, PAUSE, or HOLD mode. 

Use the PAUSE button to pause a scan in RUN mode. 

You can perform a memory reset of the CPU at any time regardless of the scan mode (RUN, 
STOP, HOLD, PAUSE, or ERROR). 
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7.1.5 Project tree description 
The S7-PLCSIM project tree is similar in design and operation to the project tree in STEP 7. The 
top level folder in the tree represents the project and shows the name of the project.  

 

The project contains the following sections: 

• SIM tables (Page 50) 

• Sequences (Page 62) 

• Event tables (Page 84) 

SIM tables folder 
A project can contain multiple SIM tables. This folder groups the project's SIM tables and 
provides functions for working with SIM tables. 

• Add new SIM table: Click this node to add a SIM table to your project. S7-PLCSIM creates 
a SIM table with a unique name and displays the new, empty SIM table in the SIM table 
editor. 

• Browse: The browse function (Page 57) allows you to create a SIM table from a STEP 7 
watch table, force table, or PLC tag table. 

• SIM table_1: By default, a new project contains a single SIM table named "SIM table_1". 

Sequences folder 
This folder contains the project's sequences. A project can contain multiple sequences. 

• Add new sequence: Click this node to add a sequence to your project. S7-PLCSIM assigns 
the sequence a unique default name and displays the new, empty sequence in the 
sequence editor. 

• Sequence_1: By default, a new project will contain a single sequence named 
"Sequence_1". 
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Event tables folder 
This folder contains the project's event tables. A project can contain multiple event tables. 

• Add new event table: Click this node to add an event table to your project. S7-PLCSIM 
assigns the event table a unique name and displays the new, empty event table in the 
event table editor. 

• Event table_1: By default, a new project contains a single event table named "Event 
table_1". 

7.1.6 S7-PLCSIM settings 

7.1.6.1 Application settings 
You can access the following application settings from the Options > Settings menu 
command: 

 
The application settings contain the following information: 
 
Setting Description 
User name User name that you can define and assign to the 

project. S7-PLCSIM creates new projects with this 
user name until you change it. 

User interface language Language for the S7-PLCSIM user interface 
Mnemonic Specifies the mnemonics for programming: 

"German" uses the German mnemonics, for 
example, "E1.0". 
"International" uses international mnemonics, for 
example, "I1.0".  

Show list of recently used projects Number of entries in the list of recently used 
projects in the "Project" menu 
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Setting Description 
Open cascade automatically in tooltips After a brief time, the tooltips expand to display a 

cascade containing additional help. 
If you deselect this option, you must expand the 
tooltips to see the cascade. 

Confirm exit in Compact view if PLC is configured. 
Requires restart of S7-PLCSIM. 

Selected: If you exit S7-PLCSIM from Compact 
view and you have a configured PLC, you must 
confirm your choice to exit S7-PLCSIM. For this 
configuration setting to take effect, you must 
restart S7-PLCSIM. 
Not selected: You can exit from Compact view at 
any time without confirming. 

7.1.6.2 Start view 
From the Options > Settings menu command, you can choose which view to launch when 
you start S7-PLCSIM: 

 

Compact view is the default setting. 

7.1.6.3 Reset to default 
From the Options > Settings menu command, you can reset S7-PLCSIM settings to defaults:  
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7.1.6.4 Storage settings 
You can access the following project storage settings from the Options > Settings menu 
command: 

 

7.1.6.5 Cycle time settings 
From the Options > Settings menu command, you can adjust cycle times for your specific 
programming device. If you have a slower or older programming device, you might want to 
disable cycle time monitoring or adjust the maximum cycle time. The simulated PLC uses your 
configured cycle time settings.  

 

7.1.6.6 Scan control settings 
You can access the following scan control settings from the Options > Settings menu 
command: 

 
These settings are enabled by default. You can set both settings, either one of the settings, or 
neither setting. 
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7.1.7 Keyboard shortcuts 
The following table lists the keyboard shortcuts that you can use in S7-PLCSIM:  
 
Shortcut Behavior 
ALT Activate or inactivate menu bar mode 
ALT+CTRL+LEFT Previous open editor 
ALT+CTRL+RIGHT Next open editor 
ALT+F4 Close the application 
ALT+F7 Toggle between Compact view and Project view 
CTRL+1 Opens or closes the project tree 
CTRL+A Select all 
CTRL+C Copy 
CTRL+DOWN Jump down 
CTRL+END Go to the very end 
CTRL+F12 Split the editor horizontally 
CTRL+F4 Closes the active editor 
CTRL+F6 Next open editor 
CTRL+HOME Go to the beginning 
CTRL+INSERT Copy 
CTRL+NUM- Zoom out 
CRL+NUM+ Zoom in 
CTRL+O Open existing project 
CTRL+RETURN Multiline text box: Insert line break without confirmation 

Grid editor: Insert row above current 
CTRL+S Save 
CTRL+SHIFT+F4 Close all editors 
CTRL+SHIFT+F6 Previous open editor 
CTRL+SHIFT+K Screen keyboard 
CTRL+SHIFT+RIGHT Increase selection to the right (depends on context) 
CTRL+SHIFT+S Save as 
CTRL+UP Jump up 
CTRL+V Paste 
CTRL+W Close project 
CTRL+X Cut 
DELETE Delete 
DOWN Move down 
END Go to the end 
ESC Stop/ cancel the current task or search, close dialog or drop down 
F1 Starts the application's help system from most user interface areas 
F12 Split the editor vertically 
F2 Rename 
F4 Open drop-down 
F6 Switches between frames of the S7-PLCSIM workspace 
HOME Go to the beginning 
LEFT Move left 
PAGE DOWN Go one page down 
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Shortcut Behavior 
PAGE UP Go one page up 
RIGHT Move right 
SHIFT+DELETE Cut 
SHIFT+DOWN Increase selection 
SHIFT+F10 Open shortcut menu 
SHIFT+HOME Increase selection 
SHIFT+INSERT Paste 
SHIFT+LEFT Increase selection 
SHIFT+PAGE DOWN Increase selection 
SHIFT+PAGE UP Increase selection 
SHIFT+RETURN Multiline text box: Insert line break without confirmation 
SHIFT+RIGHT Increase selection 
SHIFT+TAB Jump backward 
SHIFT+UP Increase selection 
UP Move up 

Microsoft Windows shortcut keys can also be useful. 

7.2 Managing projects 
S7-PLCSIM stores all project data in a unique project folder. Within the folder, S7-PLCSIM 
saves a project file with the extension .sim17:  

Creating a project 
To create a new project, go to "Project > New" from the main menu or main toolbar in 
Project view, or from the toolbar in Compact view.  

By default, a new project contains one SIM table named "SIM table_1" and one sequence 
named "Sequence_1". You can rename these tables. 

Naming a project 
S7-PLCSIM automatically creates a unique, generic name for your project, such as 
"Project23.sim17". You can rename a project as long as the new name is unique. 

Storing a project 
When you create a new project, S7-PLCSIM automatically suggests a storage location for the 
project. You can view your project's current storage location by right-clicking the project 
name in the project tree and selecting "Properties". 

To change the default project storage location, follow these steps:  

1. Select the "Options > Settings" menu command. 

2. Select the check box for "Default storage location" in the "Storage settings" area. 



 Working in Project view 
 7.3 Using undo and redo in Project view 

S7-PLCSIM V17 online help 

Programming and Operating Manual, V17, 05/2021, A5E46238743-AB 45 

3. Type the storage path, or browse to it and select it. 

4. Click the "OK" button when you are finished. 

Opening a project 
Select "Project > Open" to open an existing project. You can select a project from the list of 
recent projects, or browse to the project you want to open. You can also open a project from 
a previous version (Page 24). 

Saving a project 
To save your project with its current name and storage location, use the "Project > Save" or 
"Project > Save as" menu command. You can accept the default name and location, or change 
either or both before you save. 

Opening a saved project 
Your saved project opens with the same configuration it had when it was saved, including the 
hardware configuration and STEP 7 program, SIM tables, sequences, and workspace layout.  

Deleting a project 
To delete a project, select "Project > Delete project" and then select the project you want to 
delete. 

You can also use Windows Explorer to browse to your project’s storage location and delete it 
from there. 

7.3 Using undo and redo in Project view 
S7-PLCSIM supports undo and redo for many editing actions. You can access the undo and 
redo commands from the following methods: 
 
Undo Redo 

Toolbar button  Toolbar button  
Edit > Undo menu command Edit > Redo menu command 
Ctrl+Z Ctrl_Y 

Clearing the undo/redo queue 
The following actions clear the undo/redo queue: 

• Saving an S7-PLCSIM project 

• Closing an S7-PLCSIM project 

• Downloading a STEP 7 program 
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Each project opens with an empty undo queue. The undo options remain disabled until you 
perform an undoable action. 

Each instance of S7-PLCSIM has its own undo/redo queue. When two instances of S7-PLCSIM 
are open, the two instances are independent, so actions you take in one instance do not 
affect the other instances. 

When S7-PLCSIM is in Project view without an open project, there are no undoable actions. 

As you make edits that can be undone, those edits are added to the undo queue. The redo 
option is only available if your last action was an undo.  

If you select to undo multiple actions, each of those actions is then listed in the redo queue. 
However, as soon as you make a new edit (a new undoable action), S7-PLCSIM empties the 
redo queue and then disables the redo option. 

Interaction between undo and redo 
As you make edits that can be undone, those edits are added to the undo queue. 

The "redo" option only becomes available when you undo an action. If you select to undo 
multiple actions, each of those actions is then listed in the redo queue.  

As soon as you make a new edit that is undoable, S7-PLCSIM empties the redo queue and 
then disables the redo option. 

Redo is only available if your last action was an undo. 

7.4 Visual feedback regarding online and offline states 
The S7-PLCSIM Project view provides visual feedback of online status when there is an active 
connection to the simulated PLC. Two changes occur in Project view when S7-PLCSIM is 
online:  

• Parts of the user interface are colored orange 

• An animation appears in the lower right corner of the application: 

 

7.5 Features common to editors 

7.5.1 Overview of common features 
S7-PLCSIM has the following grid-based editor views with several common editing features:  

• SIM tables (Page 50) 

• Sequences (Page 62) 

• Event tables (Page 84) 
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7.5.2 Common editing actions 
S7-PLCSIM editors support standard clipboard actions (cut/copy/paste) for the following:  

• Text within a cell 

• Cell contents 

• Single rows (entire row selections) 

• Multiple rows (where rows are contiguous or not) 

You can select clipboard actions in the following ways: 

• Using standard Windows shortcut keys: 

– Ctrl+C for copy 

– Ctrl+X for cut 

– Ctrl+V for paste 

• Shortcut menu provided in each editor; accessible by right-clicking in the editor 

• The "Edit" menu on the main toolbar 

Pasting tags or addresses from STEP 7 
You can copy tags and addresses from STEP 7 and paste them into S7-PLCSIM sequences and 
SIM tables. You can copy from any of these STEP 7 locations: 

• PLC tag table 

• Watch table 

• Force table 

If you have added or edited tag names in STEP 7 after your last download, download the 
STEP 7 project to S7-PLCSIM to resolve the new or changed tag names. 

You can paste a structured tag (Struct) from STEP 7 to S7-PLCSIM. When you copy and paste a 
structured tag, add a period to the end of the tag name to display an Intellisense menu of the 
Struct components. You can then select the specific component to add to the sequence or 
SIM table. 

Cutting and pasting between separate instances of S7-PLCSIM 
If you cut rows from one instance of an S7-PLCSIM sequence or SIM table and paste into 
another S7-PLCSIM instance, S7-PLCSIM does not remove the rows from the source instance. 

Selecting multiple rows for clipboard actions 
S7-PLCSIM supports selecting multiple rows for clipboard actions, generally in the same way 
that Windows does. 
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You can select multiple rows in the following ways: 

• Left-click on the selection column for a row, then drag the mouse downward or upward to 
select multiple contiguous rows. 

• Click the selection column for a row, then press and hold the Shift key and click another 
row (above or below the original) to select all the rows between the two clicks. 

• To select multiple noncontiguous rows, click the selection column for a row, then press 
and hold the "Ctrl" key while selecting other rows. All the clicked rows then become part 
of the selection. 

Renaming cell contents 
You can rename the contents of many cells. When renaming is possible, you can rename the 
contents using one of these methods: 

• Select rename from the shortcut menu. 

• Clicking twice on a cell to get an edit field 

• Click F2 on a cell. 

7.5.3 Adding and deleting entries in the editors 
The S7-PLCSIM editors provide an empty row in which to add new entries to a SIM table, 
Sequence, or Event table. S7-PLCSIM supports adding or inserting empty rows at any valid 
location in the editor. 

• Selecting "Add row" or "Add event" causes a new, empty row to be added immediately 
below the row with current editing focus. 

• Selecting "Insert row" or "Insert event" causes a new, empty row to be added immediately 
above the row with current editing focus. 

• If you have selected multiple rows and these rows have focus, adding causes the new row 
to be added below the first selected row and inserting causes the new row to be added 
above the first selected row. Note that both of these options might not always be 
available in the sequence editor, due to the special nature of the first and last rows in that 
editor. 

The S7-PLCSIM editors also support deleting one or more rows or events. Once you have 
selected the rows or events, you can delete the selection using the shortcut menu, Edit 
menu, or toolbar button. 

7.5.4 Applying tags for addresses 
Each time you download from STEP 7, S7-PLCSIM updates tag information that has changed 
in STEP 7 since the last download. 

S7-PLCSIM resolves additions, changes, and deletions in the following areas: 

• Tag names 

• Memory and I/O assignments for tags 
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7.5.5 Auto-completion for tags 
When you download a STEP 7 project to S7-PLCSIM, the tags in the downloaded project are 
available for SIM tables and sequences. 

S7-PLCSIM supports auto-completion for entering tag names. As you type characters, auto-
complete provides a list of tag names in the downloaded STEP 7 project that correspond to 
your text.  

7.5.6 Common row indicators 
Several row indicator icons are common to both the SIM table and sequence editors: 

• Errors 

• Forced addresses 

• Fail-Safe modules and the tags associated with them 

Error indicator 
Whenever invalid data exists in an editor; it is marked as an error. 

Cells containing invalid data are colored pink, and the row containing invalid data is marked 
with an  error icon. 

Force indicator 
A "force icon"  displays for forced addresses that you download from STEP 7. It is the same 
icon as the one used in STEP 7. The icon displays for both fully- and partially-forced addresses. 
The icon displays in the following locations:  

• SIM table rows that contain a fully- or partially-forced address downloaded from STEP 7. 

• Sequence steps that contain a fully- or partially-forced address downloaded from STEP 7. 
However, if you disable the sequence step, the force icon does not display. 

Fail-Safe indicator 
In S7-PLCSIM, Fail-Safe I/O addresses are displayed with the same yellow Fail-Safe coloring as 
in the TIA Portal. 

This is true wherever Fail-Safe addresses are used: 

• SIM table editor 

• Sequence editor 
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7.6 Working with SIM tables 

7.6.1 SIM tables and the SIM table editor 
The S7-PLCSIM SIM table editor enables you to modify simulated inputs and read simulated 
outputs. It is similar to a STEP 7 watch table, but the focus is on modifying peripheral inputs 
and reading peripheral outputs. 

A simulation project can contain one or multiple SIM tables. You can configure multiple SIM 
tables concurrently for the same simulated PLC. 

Tag name and address display 
As soon as you download a program from STEP 7, any open SIM table automatically begins 
monitoring specified tags and addresses. 

Forced addresses 
Forced values supersede typical S7-PLCSIM operations. Be aware that forced values might 
alter the behavior of your simulation. 

7.6.2 SIM table editor description 
The SIM table editor consists of two sections divided by a horizontal split view. The upper 
section contains the SIM table grid and the lower section contains the control view. 

The SIM table grid 
The SIM table grid is similar in design to a STEP 7 watch table:  

 

A simulation project can contain multiple SIM tables, but each SIM table must have a unique 
name. You can rename a SIM table. 
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SIM table toolbar 
The icons on the toolbar perform the following actions: 

 
Icon Function Description 

 
Insert row Inserts a new, empty row immediately above the current cursor 

position. 

 
Add row Inserts a new, empty row immediately below the current cursor 

position. 

 
Modify all selected values Writes values in the "Consistent modify" column for rows that have the 

check box selected to write those values in consistent, or batch, mode. 

 
Enable/disable modification of non-
inputs 

By default, you can only write updates to inputs. When you click this 
button, you can also write updates to outputs, memory areas, and 
data block addresses. 
This button is only used to indicate an editing option - it is not an 
online action. 

 
Export to Excel (Page 55) Exports the contents of a SIM table in Microsoft Excel .xlsx file format. 

 
Import from Excel (Page 55) Imports the contents of a Microsoft Excel .xlsx file into a SIM table. 

 
Load project tags (Page 54) Loads all tags currently downloaded from your STEP 7 project into the 

open SIM table. This button is disabled if there are no currently 
downloaded tags. 

 
Save window settings Saves any changes you have made to the appearance of the SIM table 

editor, such as column widths. The saved settings also apply to new 
SIM tables that you create. 
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SIM table grid columns 
The following table describes the SIM table columns: 

 
Column Description 
Indicator 
(no column header) 

This column shows information about your SIM table entry. 

 
A purple tag icon appears in this column when a valid tag name is entered, or 
when you enter an address for a valid tag name from your downloaded 
STEP 7 program. 
If you have a Fail-Safe tag, the purple tag displays on a yellow background 
just as it does in the TIA Portal. 

 
A red "X" appears if there is an error with your entry. An error message will 
display. 

 
A force indicator displays if the address is forced in any way. For example, a 
partially forced address displays the same force icon in the SIM table as a fully 
forced address. 

Name Displays the tag name. 
Address Displays the tag address. 
Display format Different display formats are available and depend on the type of entry. Some examples 

include Bool, Hex, and signed decimal (DEC +/-). 
Monitor/Modify value Displays the entry's current value. 
Bits A series of check boxes (one box per bit) will display in the field if the address is a bit or byte 

address. From left to right, the bit order is: 7, 6, 5, 4, 3, 2, 1, 0. 
Consistent modify This value is written to the PLC when you click the "Modify all selected values" button. 

 

Select the check box in this column if you want the values in the row to be modified when 
you click the "Modify all selected values" button on the toolbar. 

Comment You can add a comment here to provide documentation for the SIM table entry. 

You can reorder columns in the SIM table editor. Drag a column header to its new position to 
reorder. 

SIM table view shortcut menu 
Right-click inside the SIM table grid to display the following context menu:  

 

The context menu commands provide editing functions and SIM table functions. 

For commands corresponding to buttons on the toolbar, the behavior of these context menu 
commands is the same as for the buttons. 

The Delete command allows you to delete a SIM table row or a value in an editable field.  
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The Rename command allows you to rename editable values in SIM table fields. 

Control view 
The SIM table control view contains two controls that you can use to easily adjust values: 

• A slider for adjusting analog values 

• A push button for adjusting Boolean values 

Note that you can also adjust these values in the table grid. 

The slider and push button controls are described in detail in the topic "Working with analog 
and Boolean values in Control view (Page 59)". 

Undo and redo button behavior 
You can undo and redo many actions in the SIM table. However, the following actions do not 
have undo and redo support: 

• Edit text for "Monitor/modify value" 

• Clicking the "bits" checkboxes in table view 

• Modify all selected values (toolbar button) 

• Export to Excel (toolbar button) 

• Enable/disable modification of non-inputs (toolbar button) 

Note that additional actions, such as downloading a program from STEP 7, might erase the 
contents of the undo/redo queue. 

7.6.3 Creating and populating a SIM table 

7.6.3.1 Overview of creating and populating a SIM table 
You have the following options for adding or inserting rows in a SIM table, or for creating an 
entire SIM table:  

• Loading the tags (Page 54) from the STEP 7 project 

• Copy and paste all, or a portion of, a STEP 7 tag table, watch table, or force table 

• Import (Page 55) all or a portion of, a STEP 7 tag table, watch table, or force table 

• Use auto fill (Page 56) to create additional rows based on a selected tag or address 

• Browse (Page 57) and select a STEP 7 tag table, watch table, or force table 

• Entering tag names manually 
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7.6.3.2 SIM table: load project tags from STEP 7 

You can use the "Load project tags" button  on the SIM table editor toolbar to load your 
STEP 7 tags into an open SIM table.  

Clicking this button loads all of the tags from your most current STEP 7 download. 

If the most recent download had no tags, the progress indicator from the "Load project tags" 
disappears very quickly. S7-PLCSIM loads no tags. 

7.6.3.3 Monitoring and modifying values in table view 
The "Monitor/Modify value" column displays the current value in the format you selected in 
the "Display format" column. You can modify values in the SIM table either individually, using 
this column, or in a consistent (batch) mode using the "Consistent modify" column.  

Some SIM table values might only update if the virtual PLC is in RUN mode. 

The SIM table continues to monitor and update even as you enter new values. 

Bit and byte value display 
If the address is a bit address, one check box appears in the "Bits" column.  

If the address is a byte address, eight check boxes (one check box per bit) appear in the "Bits" 
column. The order of the bits, from left to right, is: 7, 6, 5, 4, 3, 2, 1, 0. 

The following image shows the representation of bits and bytes in a SIM table: 

 

Expanding byte addresses 
When you enter a byte address, a triangle icon  appears beside the name of the entry. The 
triangle icon indicates that you can expand the entry. 

When you click the triangle icon, the byte address expands to show separate entries for each 
bit in the byte. The names and addresses for these "expanded" entries are read-only. 

Modifying non-input addresses 

By default, you can only write values to inputs. The SIM table editor toolbar button  allows 
you to also write values to outputs, memory, timer, counter, and data block addresses. 

Modifying individual values 
Use the "Monitor/modify value" and "Bits" fields to enter a value that writes immediately to 
the simulated PLC.  

To modify a value individually and immediately, simply enter the new value in the "Monitor/ 
modify value" field.  
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You can use the individual check boxes in the "Bits" field to immediately change the values of 
individual bits in a byte address. There is one check box per bit. An empty check box indicates 
a 0, or FALSE, value. A selected check box indicates a 1, or TRUE, value.  

Modifying values in a consistent (batch) mode 
You can update multiple values concurrently by entering the new values in the "Consistent 
modify" fields.  

Select the check boxes for the fields you want to modify in the column headed by the 
"lightning bolt" icon:  

 

A yellow triangle indicates that a value will be applied when you click the "Modify all selected 
values" button  on the toolbar. The button writes data for all the checked entries containing 
a modified value. If you do not have an active connection to the simulated PLC and click this 
button, a warning message appears. 

7.6.3.4 SIM table: Import and export using Microsoft Excel 
The S7-PLCSIM export button  allows you to export an existing SIM table in .xlsx format 
that can then be imported into another SIM table within the same project, or imported into a 
SIM table in a different project.  

The import button  allows you to create or expand a SIM table by importing contents from 
an .xlsx file. The .xlsx file can contain the following contents:  

• A different SIM table 

• A STEP 7 tag table, watch table, or force table 

Exporting a table from STEP 7 to a Microsoft Excel file 
To export STEP 7 tables to Microsoft Excel, follow these steps: 

1. Select tags in a STEP 7 tag table, watch table, or force table. Note that the entire table is 
exported no matter how many tags you select. 

2. Right-click and select "Export" from the shortcut menu. 

3. Select a location and name for the exported Excel file. 

4. Click "Open". 

Result: The entire table is exported with the name and location you entered. 
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Importing a table from a Microsoft Excel file into a SIM table 
To import a Microsoft Excel file into a SIM table, follow these steps: 

1. Open a SIM table. 

2. Select the "Import" button from the SIM table toolbar, or select "Import from Excel" from the 
SIM table shortcut menu. 

3. Locate the Excel file you want to import. Note that the import file must be closed for the 
import to work correctly. 

4. Click "Open". 

Result: The .xlsx file contents appear in your SIM table. 
 

 Note 
Imported files with empty address fields 

If your .xlsx file contains one or more empty address fields, a warning message displays that 
the import was only partially successful. An error icon displays in the status indicator column 
for a row that contains an empty address field. 

 

7.6.3.5 Using auto fill in the SIM table 
You can populate your SIM table by using auto fill. SIM table auto fill works in the same way 
as in a STEP 7 watch table.  

You must have at least one row already entered for auto fill to use as a basis for incrementing 
addresses. 

After a download, you can also use auto fill with the "Name" field. 

Auto fill procedure 
Use the following procedure to auto fill rows in a SIM table: 

1. Enter an address in the SIM table "Address" field. A small blue square appears on the bottom 
right corner of the field. 

 

2. Hover over the blue square. A plus sign ("fill handle") appears. Click and hold the mouse 
button while you drag straight down to fill the number of addresses you want to add. 
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3. S7-PLCSIM adds addresses in sequential order according to the selected tag. For example, 
beginning with "I0.0" as the selected address and auto filling three rows adds I0.1, I0.2, and 
I0.3. 

 

4. If entries already exist in the cells you select to auto fill, S7-PLCSIM prompts you to either 
"Overwrite existing elements" or "Insert elements". 

7.6.3.6 Browsing to a STEP 7 table to create a SIM table 
S7-PLCSIM can create SIM tables from PLC tag tables, watch tables, and force tables in STEP 7 
projects. STEP 7 with the TIA Portal Openness option must be running on your programming 
device for S7-PLCSIM to find these tables. If you have multiple instances of STEP 7 running, 
S7-PLCSIM can access the tables from all running STEP 7 instances. 

To create a SIM table from a STEP 7 table (PLC tag table, watch table, or force table), follow 
these steps: 

1. In the S7-PLCSIM project tree, click Browse in the SIM tables folder to open the Browse 
dialog. 

S7-PLCSIM displays a Browse dialog with all STEP 7 projects, PLCs, and tables from the 
running STEP 7 instances. 

2. From the Browse dialog, navigate to the folder for a PLC, PLC tags, or Watch and force tables 
for any PLC in any project. 
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3. From the list of tables, select one or more to load to an S7-PLCSIM SIM table. 

 

4. Click OK. 

S7-PLCSIM creates a new SIM table for each selection that contains all tags in the table. 
The default name for each SIM table is the table name in STEP 7.  

7.6.3.7 Creating a new sequence from recorded SIM table editor actions 
You can record actions you take in the SIM table editor to create a sequence, and then play 
back those actions by running the new sequence.  

Procedure to create a new sequence from the SIM table editor 
Follow these steps to create a new sequence from the SIM table editor: 

1. Create a SIM table. 

2. Perform a download from STEP 7. 

3. Click the "Start recording" button on the main toolbar, or select "Start recording" from the 
Tools menu. 

4. Enter actions in the SIM table section, such as adding and deleting entries, and changing 
values individually or in consistent (batch) mode. 

5. If you want to pause while you are recording your actions, click the "Pause recording" button 
on the main toolbar, or select "Pause recording" from the Tools menu. 

6. To resume recording, click or select "Pause recording" again. When you are finished 
recording your actions, click the "Stop recording" button on the main toolbar, or select "Stop 
recording" from the Tools menu. 
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Result: S7-PLCSIM creates a new sequence from your recorded actions. The sequence 
appears in the Sequences folder with a default name. 

7.6.4 Working with values in control view 

7.6.4.1 Overview of control view 
When you work with your STEP 7 program, you might want to simulate a gradual ramp up or 
ramp down of an analog value, or simulate a momentary value change for a Boolean value. 
S7-PLCSIM provides an easy way to adjust these values with two controls. 

SIM table editor: Table view and Control view 
The SIM table editor is horizontally divided into two views:  

• Table view is the upper part of the editor and contains the SIM table grid and toolbar 

• Control view is the lower part of the editor and contains a slider for adjusting numeric 
values and a push button for adjusting Boolean values 

You can manage the SIM editor workspace by resizing the Table view or the Control view, or 
by collapsing the Control view. 

Displaying Control view 
To display the Control view, you must select exactly one Table view row. If you select multiple 
rows, the Control view will be empty. 

Control view also remains empty if you select a Table view row with non-numeric data types, 
such as Char and Time_of_Day. 

Changing values in Control view 
When you switch focus from one Table view row to another, Control view displays 
information related to your newly-selected row. When you select and edit a row, the 
information in Control view updates to reflect your edits. 

Control view displays context sensitive controls based on the values in your Table view row 
selection: 

• If there is a numeric value in your selected Table view row, then Control view displays the 
slider control (Page 59). 

• If there is a Boolean value in your selected Table view row, then Control view displays the 
push button control (Page 61). 

7.6.4.2 Slider for numeric values in SIM table control view 
The SIM editor displays the slider control when you select a row that contains a numeric 
value. The value can be a BYTE, WORD, DWORD, or QWORD. 
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The slider control is not displayed if a selected row does not contain a numeric value. 

Updating values 
When you are not directly controlling the slider by clicking and dragging the handle, the 
slider updates periodically to display the actual values in your simulation. 

When you control the slider by clicking and dragging the handle, S7-PLCSIM writes the 
corresponding value to the simulation approximately every 200 ms. If you are recording a 
sequence, the values are recorded in the sequence. 

 

 Note 

Be aware that a sequence has a minimum allowable delay between steps, and the sequence 
editor will not accept a value below that minimum. 

 

You can operate the slider handle only by using a mouse. The slider does not support 
keyboard input. 

Controlling the valid value range 
Process values often have a limited range of validity. You can set a minimum and maximum 
value for the slider to reflect the valid range of values for each Table view row. 

• The slider handle is in the leftmost position at the configured minimum of the valid value 
range. 

• The slider handle is in the rightmost position at the configured maximum of the valid 
value range. 

The slider displays the minimum and maximum values with the same data width and format 
as shown in the selected Table view row. For example, a Table view row containing a DWORD 
value displayed in HEX format will display in the same manner in the slider control. HEX 
format is treated as unsigned. 

The slider accepts negative settings for signed values. 

When the process value exceeds your configured limits, the slider control moves as much as it 
can - to the minimum or maximum end of the range - since it cannot indicate the actual 
value. 

Slider range defaults 
Minimum and maximum values for "integer-like" data types default to the minimum and 
maximum values for the given data width and format. 

For example, if you have a memory address such as MW10 and choose HEX or Octal as the 
display format, S7-PLCSIM does not know if the address contains a signed or unsigned value. 
That address will therefore be treated as containing an unsigned value. 

For signed integers, the minimum value will be negative. 

Floating point values will default to a range minimum of 0.0 and a range maximum of 1.0. 
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Slider range persistence 
Minimum and maximum values are persisted with the corresponding table row. When you 
save your project, each row's minimum and maximum values are saved. 

When you cut or copy and then paste a row, the minimum and maximum values are pasted. 

Minimum and maximum values are included when importing and exporting SIM table 
contents. 

7.6.4.3 Push button for Boolean values in SIM table control view 
The SIM editor displays the push button control in Control view when you select a row 
containing a Boolean value. 

Push button use and behavior 
The push button control operates much like a physical momentary push button. When you 
click and hold the button, the associated process value is modified. When you release the 
button, the process value is restored to its default state. 

Like a physical push button, the button is write only. The visual state of the button does not 
change to match the actual process value.  

 

 Note 

If you use another method to change the value at the same time, such as by running a 
sequence, the button might behave in an unexpected manner. 

 

7.6.5 SIM table error conditions 
The SIM table editor recognizes several error conditions. When an entry error occurs, the cell 
containing the error turns pink, the  icon appears in the indicator column, and S7-PLCSIM 
does not gather data for that entry. S7-PLCSIM does continue to monitor all valid entries.  

S7-PLCSIM recognizes the following error conditions at the time of entry: 

• Address is invalid (for example, syntactically incorrect) 

• Address is out of range; that is, the address is too large for the physical memory of the 
hardware 

• The Monitor/Modify value is out of range for the data type 

Empty address field in imported file 
If an imported Microsoft Excel .xlsx file contains one or more empty address fields, a warning 
message informs you that the import was only partially successful. Error icons in the status 
indicator column indicate rows with empty address fields.  
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7.7 Working in the Sequence editor 

7.7.1 Sequences and the Sequence editor 
The purpose of a sequence is to simulate an external process interacting with your program. 
An external process interacts with the PLC through inputs. Any time you enter an input 
address (%I) in the sequence editor, S7-PLCSIM converts the address to a peripheral input 
address (%I:P) to more accurately simulate a physical input signal.  

Sequence editor and addresses 
You can manipulate any of the following address areas within a sequence:  

• Peripheral Inputs (%I:P) 

• Outputs (%Q) 

• Memory (%M) 

• Data block (%DB) 

• Timer (%T) 

• Counter (%C) 

With the sequence editor, you can define a set of timed value changes on inputs, outputs, 
and memory addresses. The sequence can be used to simulate the behavior of external 
devices on the running program. This allows you to observe the effect of your program logic 
and to make any adjustments that might be necessary.  

A project can contain multiple sequences, but you can run only one sequence at a time. You 
might want to create multiple sequences to see the effect of various adjustments to your 
program logic rather than modifying a single sequence many times.  

When you save your project, you save the sequences. You can replay them multiple times to 
assist in debugging your program.  

When a sequence is no longer useful, you can delete it from your project. 

Forced addresses 
Forced values supersede S7-PLCSIM operations. Be aware that forced values might alter the 
behavior of your simulation.  

Sequences and breakpoint functionality 
When the program in the CPU reaches a breakpoint, S7-PLCSIM takes the following actions: 

• Enters the HOLD state 

• Either pauses or continues running sequences based on your selections in Settings 
(Page 42) 

When the CPU continues past a breakpoint, S7-PLCSIM restores the scan control options 
(Page 90) in the task card. 
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Multiple sequences 
You can have multiple sequences in a single project, but you can only run one sequence at a 
time. When a sequence is running, the "Start sequence" button is not active for any other 
sequence.  

7.7.2 Sequence editor description 
S7-PLCSIM displays the sequence editor when you add a new sequence or edit a sequence: 

 

A simulation project can contain one or multiple sequences. Each sequence must have a 
unique name. 

Sequence editor toolbar 
The Sequence editor toolbar includes the following functions:  
 
Button Function 

 
Insert step  

Inserts a new empty step immediately above 
the currently selected step. 

 
Add step  

Inserts a new empty step immediately below 
the currently selected step. 

 
Enable step  

Enables a previously disabled step. 

 
Disable step  

Disables a step so it will be skipped when you 
run the sequence. 

 
Step time adjustment  

Adjusts the time of the selected steps by a 
specified time increment. 

 
Start sequence  

Plays the sequence from the beginning. 
The button is only available when the 
following conditions are true: 
• There are no other sequences currently 

running. 
• There are no errors in the sequence. 
You can also click this button to resume a 
paused sequence. 
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Button Function 

 
Stop sequence  

Immediately stops a running sequence. 

 
Pause sequence  

Pauses the sequence at the step that will 
execute next. 
You must click the "Start sequence" button to 
resume your paused sequence. 

 
Repeat sequence  

Loops your sequence until you manually stop 
the sequence.  

 
Default interval and time format settings  

Allows you to enter a time in milliseconds to 
increment the time in the "Time" column for 
newly added rows. The valid range is 0 -
 3600000 ms. Use the time format settings to 
change the time format. 

 
Export to Excel  

Exports sequence to Excel format. 

 
Import from Excel  
Import from trace measurement  

Allows you to select to import either an Excel 
spreadsheet or a trace measurement file. 

 
Execution time 

Displays the total execution time for a running 
sequence, as well as the number of repetitions 
for a repeating sequence.  

 
Save window settings 

Saves any changes you have made to the 
appearance of the sequence editor, such as 
column widths and split windows. The saved 
settings also apply to new sequences that you 
create.  
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Sequence editor columns 
 
Column Description 
Indicator (no column 
title)  

This column displays icons to indicate the following information: 

 
The first step in the sequence 

 
The last step in the sequence 

 
The step that is executing during playback 

 
An error in the sequence 

Time  Displays the time in hours:minutes:seconds.fractional seconds (00:00:00.00). 
The maximum time allowed is 23:59:59.95. 

Name  Displays the tag name.  
Address  Displays the memory address affected by the step. 
Display format  
 

Different display formats are available and depend on the data type of the 
tag. For example, some of the available display formats include Bool, Hex, 
and floating-point number. 

Action  For the first step in the sequence, the only option is "Start sequence". 
For the last step in the sequence, you can: 
• Stop the sequence 
• Repeat the sequence 
For action steps, you can select: 
• Set to value 
• Set to frequency (for input bit memory only) 

Action parameter  Action parameters based on the Action column: 
• For "Set to value", you can enter a numerical value that is compatible with 

the entry's data type. 
• For "Set to frequency", you can enter a frequency in Hertz. 

Comment  You can add a comment here to provide documentation for the step. 

Sequence editor rows (steps) 
Each row in the Sequence editor represents a step in the sequence. The icons in the indicator 
column indicate the first and last step, which step is executing during playback, and whether 
a step has an error:  
 
Step and related icon Description 

 
Start step 

This is a fixed row that does not accept entries. It contains a time of 
"00:00:00.00". 
There are two options in the Action column: 
Start immediately  
Trigger condition  

Editable steps Steps with times between the first step and the last step in the sequence.  

 
Stop step 

The last step in a sequence. The Action column contains the text "Stop 
sequence" or "Repeat sequence".  
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Step and related icon Description 

 
Currently executing 
step 

Indicates the step that will execute next. If you set the same execution time 
for more than one entry, all of the steps will show the green arrow. 

 
Error indicator 

Indicates that the step contains an error. A message displays information 
about the error.  
 

Sequence editor context menu 
Right-click anywhere in a step to display the following context menu:  

 

The context menu commands provide common editing functions and Sequence editor 
functions. 

For commands corresponding to buttons on the toolbar, the behavior of these context menu 
commands is the same as for the buttons. 

The Delete command allows you to delete a sequence step or a value in an editable field.  

The Rename command allows you to rename editable values in Sequence editor fields. 

7.7.3 Breakpoint functionality 
S7-PLCSIM V17 supports breakpoints for S7-1500 and ET 200SP CPUs. 

When your STEP 7 program triggers a breakpoint, the simulated CPU enters the HOLD 
operating mode and your simulation stops executing. 
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Breakpoint behavior in a sequence 
If you have a sequence running when a breakpoint triggers, S7-PLCSIM operates as follows: 

• The sequence pauses while the CPU is in HOLD mode. 

• The Play, Pause, and Stop commands are disabled. 

The paused sequence resumes when the CPU exits HOLD mode. 

Visual feedback during HOLD mode 
The PLCSIM user interface provides visual feedback to show that the CPU is in HOLD mode. 

• The simulated PLC LEDs flash in the same pattern as a physical CPU. 

• In Project view, if you have created a project in S7-PLCSIM, an icon appears next to the PLC 
in the project tree just as it does in the TIA Portal project tree. 

7.7.4 Undo and Redo in the Sequence editor 
The Sequence editor supports undo and redo for many actions you perform. However, some 
actions cannot be undone or redone.  

Examples of actions that do not have undo and redo support include: 

• Export to Excel (toolbar button) 

• Play sequence (from toolbar button or shortcut menu) 

• Stop sequence (from toolbar button or shortcut menu) 

• Pause sequence (from toolbar button or shortcut menu) 

• Sorting columns 

• Selecting or deselecting "Repeat sequence" (from toolbar button) 

• Edit execution time 

Note that additional actions might also erase the contents of the undo/redo queue. 

Undo and Redo during sequence playback 
Undo and redo are disabled when a sequence is playing or paused. This is true even when the 
playing sequence does not have the editing focus or when the playing sequence is not 
visible.  

When the playing sequence ends or you explicitly stop it, undo and redo again become 
enabled. Any editing actions you perform during sequence playback will be visible in the 
undo queue. 
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7.7.5 Creating and populating a sequence 
In addition to creating sequences and entering and editing steps, S7-PLCSIM provides 
additional methods for performing tasks in the Sequence editor:  

• Use auto fill to create additional steps based on a selected address or tag name (Page 68). 

• Create a new sequence from recorded SIM table editor actions (Page 68). 

• Copy and paste all, or a portion of, a STEP 7 tag table, watch table, or force table. 

• Import all, or a portion of, a STEP 7 tag table, watch table, or force table using Microsoft 
Excel (Page 70). 

• Import a trace measurement file from STEP 7 to create a sequence (Page 71). 

7.7.5.1 Sequence: Using auto fill 
Using auto fill with a sequence works in a different way than it works in a SIM table. In a 
sequence, it is more useful to use auto fill to copy the contents of the auto filled cell than to 
increment that cell. You can then apply different start times to the same address to see the 
effect on your program.  

Before download, you can use the Address field as the starting field for auto fill. After 
download, you can use either the Name or Address field for auto fill. 

Auto fill behavior and the last sequence step 
If you have defined a time for the last step in the sequence and auto fill would result in 
exceeding that time because of the Default interval, S7-PLCSIM automatically adjusts the time 
for the last step when you perform the auto fill.  

Auto fill and the Default interval time 
Before auto filling starts, the time in the Default interval is read. The Default interval value is 
50 ms, and you cannot have a Default value less than 50 ms. The auto fill process uses this 
time to increment the time in the auto filled steps. Each auto filled step will have the same 
address as the field you selected as the basis for auto fill.  

7.7.5.2 Recording a sequence from SIM table actions 
You can create a sequence by recording actions (Page 58) you take in a SIM table (Page 50). 
You can use this recording to generate a sequence based on the timing of your recorded 
actions.  

Recordable actions from a SIM table 
When you record actions, S7-PLCSIM creates a sequence step for every action that changes a 
value at an address. For example, when you make a change to a value in the "Monitor/Modify 
value” column, S7-PLCSIM records a new sequence step. The sequence step time is the 
relative time of when you performed the action from the time you started recording. 
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If you make multiple changes to a value over time, each of those changes becomes a step in 
the created sequence. 

S7-PLCSIM creates sequence steps for actions such as clicking bit checkboxes to change 
values in the "Bits" column, or by using the "Consistent modify" column to change a single 
value or multiple values. 

S7-PLCSIM rounds the times for sequence actions to the nearest 10 ms, in conformance with 
minimum sequence step time resolution specifications. 

Recording actions 
When you open a SIM table, S7-PLCSIM enables the following buttons in the Tools menu and 
on the toolbar buttons: 
 

 
"Start recording" button 

 
"Stop recording" button 

 
"Pause recording" button 

When you click the "Start recording" button, S7-PLCSIM begins to record specific actions and 
creates a sequence from those actions. The Pause and Stop buttons are then active. 

Pausing the recording 
When you click the "Pause recording" button, S7-PLCSIM pauses the recording clock and stops 
recording actions. Any actions you take while the sequence is paused are not included in your 
recording. When you click the "Pause recording” button again, S7-PLCSIM continues 
recording.  

Ending the recording session 
When you have recorded all the actions you want for your sequence, end the recording 
session by clicking the "Stop recording” button on the SIM table toolbar. S7-PLCSIM creates a 
new sequence from your recording, which contains a step for each action that results from a 
value change for an address. S7-PLCSIM assigns a time for each step that is relative to the 
time the action was recorded. Sequences that are generated from a recording always have a 
first step with the action set to "Start immediately". 

Editing and playing back a recorded sequence 
When you open a sequence that S7-PLCSIM created from actions that you recorded in the SIM 
table editor, you see that the times for the sequence steps match the times for the actions 
you entered in the SIM table editor.  

You can use the sequence the way it is, or edit the times in the "Time" column for individual 
steps.  

To play back a recorded sequence, simply click the "Start sequence" button. 
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7.7.5.3 Sequence: Import and export using Microsoft Excel 

You can use Microsoft Excel .xlsx files to export from and import to a sequence by using the 
export and import buttons  just as you would for a SIM table, but there are 
differences from the way export and import work between a SIM table and a sequence. 

Editing an exported file 
If you edit fields, including values, in an exported sequence file in Microsoft Excel, and then 
import that file into S7-PLCSIM, the results might be different than you expect.  

You can address this issue in one of two ways: 

• To prevent the issue, you can edit the exported Excel file by changing the format of the 
time and other numerical field(s) to be text fields, and then edit the Excel file. 

• You can import the file and then edit the incorrect values in the sequence editor. 

Considerations for using import and export with a sequence 
You can import an .xlsx file into an empty sequence or into a sequence that already contains 
steps. Make sure that the imported file is not currently open in Excel or the import will fail.  

The import operation does not overwrite the first or last step in a sequence because these 
steps are reserved. 

You can export a sequence to import into another project. 

If your .xlsx file contains one or more rows with empty address fields, the rows are imported 
into the sequence as empty steps. 

Importing into an existing sequence 
If the sequence already contains entries, S7-PLCSIM adds the imported rows at the bottom of 
the existing entries and before the last step.  

If you have defined a time for the last step in the sequence and the import results in 
exceeding that time, S7-PLCSIM automatically adjusts the stop time to accommodate the 
imported steps. 

Importing watch table entries containing structured tags 
When you import a watch table that contains structured tags, the cells containing the 
structured tags turn red in S7-PLCSIM. Click the cell, add a period to the end of the tag name, 
and a drop-down list displays all of the tag's subnodes. Select the subnode tags to use in the 
sequence.  
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7.7.5.4 Sequence: Import a STEP 7 trace to create a sequence 
S7-PLCSIM can create sequences based on trace measurement files that were exported from 
STEP 7. Supported formats are: 

• .ttrec 

• .ttrecx 

• .csv 

Importing the trace file 
To import a trace measurement file, follow these steps: 

1. Select "Import sequence from trace measurement" from the shortcut menu using one of the 
following methods: 

– Right-clicking the Sequences folder in the project tree 

– Clicking the Import button dropdown arrow from the sequence toolbar 

– Right-clicking within the sequence grid 

2. Navigate to and select a trace measurement file. 

Trace measurement addresses 
A trace can record measurements for many addresses. You might not want to include all trace 
addresses in your sequence. For example, the trace measurement might include recordings 
for output addresses (%Q memory). These addresses are not valid for an S7-PLCSIM 
sequence. 

S7-PLCSIM displays a trace measurement dialog for your selected trace file: 

• S7-PLCSIM imports all addresses from the trace measurement. 

• S7-PLCSIM displays tag names for addresses with available tag information. The tag names 
come from current configuration downloaded to S7-PLCSIM. They do not come from the 
imported trace measurement. For addresses with no available tag name, S7-PLCSIM 
displays "----". 

• By default, S7-PLCSIM selects all addresses except output addresses. Output addresses 
appear in the list but are not selected for import. 

After you have selected the addresses to include and click "OK", S7-PLCSIM generates a 
sequence from the trace measurement.  

 

 Note 

Trace measurement files contains tag information. If tag assignments change in the STEP 7 
project, you must download the project with the changes to S7-PLCSIM. 
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Details about sequence generation 
The sequence is generated according to the following rules: 

• S7-PLCSIM creates an "initialization step" for each included address. This step corresponds 
to the time of the first sample in the trace file. The address in the sequence is the address 
in the first sample in the trace file. Each initialization steps includes a comment that says: 
"Initial step". If you do not want to use initialization, you can edit, disable or delete the 
steps. 

• S7-PLCSIM creates a sequence step for each change of value at one of the included 
addresses. 

 
  Note 

Trace measurements are taken at each sample time. No sequence step is generated if the 
value of the address has not changed since the last sample time. 

 

• The sample time for a trace can be much faster than the minimum increment time 
between sequence steps. S7-PLCSIM adds a sequence step for each sample in the trace 
file. If the time difference between two samples in the trace file violates the minimum 
sequence step increment time, the sequence step displays an error. You must correct all 
sequence step time errors before you can use the sequence. 

• The trace supports triggering the recording based on a tag value. When you select this, 
the trace also supports recording values before triggering. This means the measurements 
during this pre-trigger time have negative time values. The S7-PLCSIM sequence does not 
support negative times for steps. When a measurement has negative times, the time 
values are adjusted so that the first measurement time has a value of zero in the 
sequence. Subsequent step times are converted to positive values. 

After you create a sequence from an imported trace measurement file, you can edit it. There 
is no further connection to the original TIA Portal trace. 

7.7.6 Methods for starting a sequence 

7.7.6.1 Sequence start action 
The first row of the sequence defines the start condition for the sequence. The start condition 
is one of two actions: 

• "Start immediately". When you select this option, the first step of the sequence (the 
second row in the sequence editor) will immediately become active, and the execution 
time for the sequence will begin to count. 

• "Trigger condition". For this option, you must define a trigger condition that will be 
evaluated to determine when the sequence executes. When you have defined a trigger for 
the sequence, and then select to play the sequence, the first step in the sequence will only 
become active when the trigger condition is satisfied. 

Select the start condition by clicking the "Action" column in the first row: 
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The default start action for a new sequence is "Start immediately".  

Start immediately 
When you select this option, the first step of the sequence (the second row in the sequence 
editor) becomes active, and the execution time for the sequence begins to count. 

"Start immediately” is the default start action. When you select this start action, you do not 
need to edit any other fields. The "Time” field displays 00:00:00.00 (or the equivalent time, 
based on your selected time format). It is not editable. The "Action parameter” is not 
applicable for the "Start immediately" action. 

Trigger condition 
When you select this option, you must define a trigger condition (Page 73) that S7-PLCSIM 
evaluates to determine when your sequence begins to execute. When you define a trigger 
condition and then play the sequence, the first sequence step executes only when the trigger 
condition occurs. 

For a trigger condition, you must define the start condition under the "Action parameter” 
column. The trigger is a specific condition for a single tag (or address), like the trigger 
condition for a STEP 7 trace.  

7.7.6.2 Starting a sequence with a trigger condition 
Sequences that begin with a trigger condition (Page 72) require an action parameter. To 
configure the action parameter, click the Action parameter dropdown to configure the 
following information: 

• Tag or address to be used for the trigger 

• Event that will be monitored 

• Trigger value for the tag (if required) 

To input the tag or address, click the "Trigger tag” control to see a list of all available tags: 
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Select a tag from the list, or enter a tag name in the field. 

You can also enter an address into the "Trigger tag” field. If the address has an associated tag, 
S7-PLCSIM displays the tag name for the address you enter. If the address does not have an 
associated tag, S7-PLCSIM displays the address. 

Selecting the tag or address also determines what events are available. For example, you can 
test an input bit (Boolean) for the event "= TRUE". For value comparisions, you enter a specific 
value. 

To cancel your edits, click the  button.  

To accept and apply your changes, click the  button. The sequence then shows your Action 
parameter for the trigger condition: 

 

7.7.6.3 Repeating a sequence 
The last step in a sequence is the "Stop sequence” step. For sequences that don't repeat, the 
sequence stops executing at the time indicated in this step. Any active "Set to frequency” 
actions stop, and the sequence returns to a stopped, editable state. You can, however, 
configure your sequence to repeat in a loop 

Repeating a sequence from the toolbar button 
To cause a sequence to repeat in a loop, click the "repeat sequence” toolbar button . When 
a sequence is repeating, the button appears pressed. 

A repeating sequence has the following functionality: 

• When the running sequence reaches the "Stop sequence” step, any active "Set to 
frequency” actions end. 

• The first step of the sequence becomes active, and the sequence once again proceeds 
through the steps. 

• The time that displays in the "Execution time” field is the time for the current iteration of 
the sequence, rather than the total cumulative time since the sequence first began 
executing. The current iteration for the repeating sequence (1…n) appears in parentheses 
next to the execution time. 

You can stop a repeating sequence in the following ways: 

• Click the stop button. The sequence stops immediately. Clicking the stop button does not 
affect the state of the "repeat sequence” button. 

• De-select the "repeat sequence” button. This causes the sequence to stop when the time 
for the "stop sequence” step is reached. 

 

 Note 

S7-PLCSIM does not save sequence repeat settings in the S7-PLCSIM project. 
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Repeating a sequence with a trigger condition 
When a repeating sequence starts with a trigger condition, S7-PLCSIM evaluates the starting 
condition each time the sequence repeats. The sequence continues to repeat if the trigger 
condition is true. If the trigger condition is not true, the sequence pauses until the trigger 
condition becomes true. 

7.7.6.4 Visual feedback while running a sequence 

Visual feedback in Project view while playing a sequence 
S7-PLCSIM provides the following visual feedback while a sequence is actively running:  

 

 
In the project tree, a "running" icon displays next to the sequence that is 
currently running. If the sequence is paused, a "pause" icon appears in place of 
the "running" icon. In this way, you can select the correct sequence that you 
want to stop. 

Sequence playing: 

 

The "sequence playing" icon appears in the lower right side of the Sequence 
editor window while the sequence is running. 

 
The "step execution" icon moves from step to step in the sequence, indicating 
which step is executing. If you defined multiple steps to begin at the same 
time, all of the steps display the green arrow. 

 
The execution time is displayed in the Sequence editor toolbar.  

Visual feedback after stopping a sequence 
You can tell when a sequence has stopped running from the following visual indicators: 

• There is no "running" icon next to the sequence name in the Project tree. 

• The "sequence playing" icon no longer appears in the lower right corner of the Sequence 
editor window. 

• The "step execution" icon stops on the last step executed. 

• The execution time stops and displays the total sequence run time. If the sequence is a 
repeat sequence, the number of repetitions displays in parentheses. 

7.7.7 Sequence actions and action parameters 
Each entry, or step, in a sequence represents an action to take on the specified address at the 
time specified in the "Time" column. The type of action that can be specified depends on the 
data type of the address.  

You can specify an address by tag name in the "Name" field or by address in the "Address" 
field. A sequence entry's address determines its data type and available actions.  
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Sequence example using bit address 
The following example describes how the address for the step determines available options 
for a bit address: 

• Enter an input bit address either by address or by tag name. 

• S7-PLCSIM populates the remaining fields in the sequence row with default values. 

• The "Set to value" action is the default action. You have two possible options for the action 
parameter: FALSE or TRUE. 

• If you want the "Set to frequency" action rather than the "Set to value" action, select it 
using the drop-down list and enter a frequency in Hertz in the "Action parameters" field. 
The input will pulse at that frequency when you run the sequence. 

Sequence action: "Set to value" 
"Set to value" is a discrete action. S7-PLCSIM writes the value once to the peripheral input. 
Because there is no physical I/O to overwrite this action, the input retains its value until 
another action changes it.  

Sequence action: "Set to frequency" 
The "Set to frequency" action is only available for input bit memory.  

When the action is "Set to frequency", you must specify a frequency value in Hz. S7-PLCSIM 
pulses the bit at the configured frequency until the sequence stops. If you have selected 
"Repeat sequence" for the last step, S7-PLCSIM continues to pulse the input bit until you stop 
the sequence.  

7.7.8 Time-related Sequence information 

7.7.8.1 Sequence time entry 
Your sequence entries sort and run based on the contents of the "Time" field. The time 
displays in the format: Hours:minutes:seconds.fractional seconds (00:00:00.00).  

If you select the "Time" field and simply enter a number (such as "12", for example), 
S7-PLCSIM interprets and displays the number as 12 seconds (00:00:12.00). To get hours, 
minutes, and fractional seconds, you must explicitly enter the time using the proper format.  

The maximum time allowed for an entry is 23:59:59.95 (S7-PLCSIM rounds sequence time 
entries to the nearest 50 milliseconds).  

The following table shows examples for time values in your sequence: 
 
Value entered Resulting time value 
12 00:00:12.00 
12.2 00:00:12.20 
.02 00:00:00.02 
2:2 00:02:02.00 
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Value entered Resulting time value 
12:12.12 00:12:12.12 
Empty 00:00:00.00 
Any illegal entry, such as text "abcd" The cell turns pink, an error icon displays, and the text that 

caused the error displays.  

Order of sequence steps 
You do not need to add steps to the sequence in the order they should be executed. You can 
enter the steps in any order, and they run based on the times you enter in the "Time" column.  

You can sort your steps by time before running the sequence by selecting the "Time" column 
header. 

Sequence time entry rules 
You can define multiple entries with the same time as long as they are not for the same 
address. An error occurs if you define multiple actions for the same address with the same 
time.  

 

 Note 
Multiple steps with the same time 

If you define multiple actions with the same time for different addresses, no error displays, 
but there is no way to know which action will execute first until you play the sequence. This 
could result in different ending values for your addresses. 

 

You can sort on the Address column to see the actions based on which input addresses are 
affected.  

Sequence end times for Stop and Repeat sequences 
The time for the last step of your sequence must be equal to or greater than the time for the 
last step of your sequence plus 50 ms for both Stop and Repeat sequences. 

Sequence time entry examples 
If you want an input point to pulse at a certain frequency for five seconds and then want the 
input cleared, you could use one of the following two sequence examples to accomplish this.  

Example: Ending a set to frequency action after five seconds 
For the first step, choose "Set to frequency" as the action and enter the frequency in Hertz in 
the "Action Parameters" field. 

For the second step, enter a time of 00:00:05.00 in the "Time" field, choose "Set to value" as 
the action, and enter the value "0" in the "Action Parameter" field. 

The pulse generation stops after five seconds. 
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Example: Ending a sequence after five seconds 
You can also enter 00:00:05.00 in the Time field for the last step in the Sequence. This also 
stops the pulse generation after five seconds if you have selected "Stop sequence" in the last 
step. 

7.7.8.2 Sequence step timing 
You can specify sequence step timing in two ways: 

• Actions occur at the same time 

• Steps execute sequentially 

You can create multiple steps to set the values for several addresses at the same time. This is 
valid. If you create multiple steps to set the value for the same address at the same time, this 
is an error condition. S7-PLCSIM indicates the error condition by changing the color of the 
error fields to red. 

If the sequence steps contain different times, S7-PLCSIM enforces a minimum time of 5 ms 
between steps. If you enter a time that is less than 5 ms after the time in the previous step, 
S7-PLCSIM rounds up the difference to 5ms. The stop sequence time must be at least 5 ms 
after the last step. 

7.7.8.3 Edit execution time 
When you pause a sequence, you can edit the execution time. Editing the current execution 
time allows you to restart the sequence at a different location. You can either rewind to a 
prior step or skip ahead to a later step. 

Example: Editing execution time to skip ahead 
Consider the following sequence that you have paused at 12.82 seconds: 

 

No steps execute while the sequence is paused. 

Now, assume you edit the execution time to be 21.5 seconds and then click "Start sequence”: 
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Sequence operation starts at the step corresponding to the new execution time. In this 
example, the sequence skips the step defined at time 21.0 seconds and begins operation at 
the step defined for time 21.50 seconds. 

If you edit the execution time so that it is between two steps, clicking Start sequence causes 
the sequence timer to start and the next step becomes active when its time is reached. 

Note that the step that was active when you paused your sequence is a "set to frequency” 
action. Since this step was active when you paused the sequence and then moved the 
execution time forward, this step is still active when the sequence is started again.  

Here is exactly what happened in the above example:  

• When the sequence was paused, the active step was running a "set to frequency” action 
for %I0.3. 

• While the sequence was paused, the execution time was edited to skip the next step in the 
sequence. This step would have stopped the "set to frequency” action. 

• By skipping this step, the set to frequency action for %I0.3 is allowed to remain active. 

Example: Editing execution time to skip back 
You can also edit the execution time to replay a portion of the sequence. Here is our original 
example of a sequence paused at 12.82 seconds: 

 

Now, assume you edit the execution time to be 0.00 

The step that was active when you paused the sequence at 12.82 seconds (set to frequency 
for %I0.3) is no longer active. S7-PLCSIM resets the active step to the step at 00.00 seconds.  

Setting the execution time to 0.00 restarts the sequence. In the example above, the sequence 
starts on a trigger condition. S7-PLCSM evaluates the trigger condition and proceeds if the 
trigger condition is true. 



Working in Project view  
7.7 Working in the Sequence editor 

 S7-PLCSIM V17 online help 

80 Programming and Operating Manual, V17, 05/2021, A5E46238743-AB 

Additional information 
You cannot set the execution time past the time of the last step.  

When you save your project, S7-PLCSIM does not save the current execution time in the 
project. 

7.7.9 Inserting, adding, and deleting sequence steps 
When you open a new sequence, it contains three rows, or steps:  

• A first step containing the "first step" icon  in the indicator column, "00:00.00:00" in the 
"Time" column, and "Start immediately" in the "Action" column. You cannot edit this step. 

• An empty step with "00:00.00.00" in the "Time" column. 

• A final step containing the "last step" icon  in the indicator column, "00:00.00:05" in the 
"Time" column, and "Stop sequence" (the default value) in the "Action" column. 

You can create the first step in a new sequence by editing the empty row. 

Inserting a step 
When you insert a step, the new step appears above your currently selected step. 

You can insert a step in one of the following ways: 

• Click the "Insert step"  button on the Sequence editor toolbar 

• Right-click anywhere in a step and select "Insert step" from the shortcut menu 

Adding a step 
When you add a step, the new step appears below your currently selected step. The time for 
the added step will equal the time for the currently selected step plus the default interval 
time. 

You can add a step in one of the following ways: 

• Click the "Add step" button  on the Sequence editor toolbar 

• Right-click anywhere in a step and select "Add step" from the shortcut menu 

Using the default interval 
If you want to change the default time for an added step, enter a different value in the 
"Default interval" text box on the Sequence editor toolbar. The time for the new step will be 
the time for the selected step plus the default interval time value.  
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For example, if the time for the current step is "00:00:05.00" and you enter "2000" for the 
default step interval, your added step will have the time "00:00:07.00".  

When you add a new step, the default interval time is added to the time of the selected step 
and all subsequent added steps.  

 

 Note 
Effect of the default interval on inserted steps 

The default step interval is only used for added steps. If you insert a step, the time for the 
inserted step is the time for the currently selected step minus the default interval time value. 

 

The valid range for the default interval is 50 to 5000 ms. Your entry is rounded to the nearest 
10 ms. For example, if you enter "1445" the default interval rounds to "1450". 

Deleting a step  
To delete a step, select the step you want to delete and perform one of the following actions: 

• Click the "Delete" key on your keyboard 

• Click the "Delete" toolbar button 

• Right-click and select "Delete" from the shortcut menu 

7.7.10 Enable and disable sequence steps 
You can temporarily disable one or more steps in a sequence. Disabled steps are ignored 
when you play a sequence. This functionality provides you with flexible way to debug your 
sequence. You can re-enable the disabled step(s) with a single click so that the steps are 
included the next time you play the sequence. 

To disable a step, follow these steps: 

1. Select the step by either selecting the entire row, or clicking a cell in the row 

2. Click the "Disable step" button  on the Sequence editor toolbar. 

To disable multiple steps, select the steps and and click the "Disable step" button. 

To re-enable a step, select the step and click the "Enable step" button . 

Tips regarding disabling and enabling steps 
You can disable a step even if it contains an error. In this case the error icon for the row will 
be replaced by the disabled icon. This allows you to play the sequence and ignore the error. 

You can edit a disabled step.  

You cannot disable either the "Start sequence" step or the "Stop sequence" step.  

The enabled or disabled state of a step is preserved when you copy and paste it and when 
you export and import a sequence. 
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7.7.11 Step time adjustment 
When editing and debugging a sequence, you might find that you need to insert a step in the 
middle of a sequence. As a part of this operation, you might want to delay all the following 
steps by some amount of time. 

To accomplish this, follow this example: 

• After testing your sequence, you determine that you need a new step between the 
existing steps at 02.00 seconds and 02.50 seconds. First use the "Insert step" button to 
create an empty step at the correct position, then edit the step. 

• You want to add a 0.50 second delay to all of the following steps in the sequence. You can 
do this by manually editing the time for each step, or you can select the steps, right-click 
and select "Step time adjustment". 

• This action allows you to add a positive or negative time to all the selected steps. Selecting 
this context menu option will display a small dialog box where you can enter an amount 
of time to add to each step. 

– Adding a positive time increases the "Time" value for each of the steps by that amount. 

– Adding a negative time decreases the "Time" value for each of the steps by that 
amount. If the decrease would cause any times to become negative, then these step(s) 
are set to a time of 00.00. 

The step time adjustment action does not apply to the start step of the sequence. This step 
always begins at time zero. If the start step is included with a multiple row selection, there is 
no change to the start step. 

The step time adjustment action does apply to the "stop sequence step". You can edit the 
time for this step either individually or together with other steps. 

The minimum delay (either positive or negative) is 10 ms. 

"Step time adjustment" is an action you can undo.  

A dialog box with a text entry field is used to indicate the delay time. 

7.7.12 Sequence error conditions 
When an error condition exists for a sequence entry, the cell containing the error turns pink 
and an  icon appears in the indicator column. You can hover over the erroneous entry to 
display an associated error message.  

You cannot play a sequence as long as error conditions exist in the sequence.  

The possible errors for a sequence are as follows: 
 
Error Description 
Undefined tag name Tag name entered has no match in the download from STEP 7 
Invalid address Address is syntactically incorrect 
Invalid time Time is syntactically incorrect 
Invalid Action parameter Action parameter is syntactically incorrect, or is out of range for 

the address 
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Error Description 
Action parameter out of range for 
"Set to frequency" value 

The valid range is 1 to 100 Hz 

Duplicate steps Two steps are attempting to act on the same address at the 
same time 

Steps too close together S7-PLCSIM enforces a minimum 5 ms time difference between 
any two steps 

Not online STEP 7 is not online when attempting to run a sequence 
Import only partially successful One or more missing addresses in a Microsoft Excel file 

Note that the Sequence editor does not perform a range check on addresses. 
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 Event simulation 8 
8.1 Event simulation overview 

S7-PLCSIM enables you to create event tables for simulating the following events: 

• Hardware interrupt (OB 4x) 

• Diagnostic error interrupt (OB 82) 

• Pull or plug of module (OB 83) 

• Rack or station failure (OB 86) 

S7-PLCSIM responds to event triggers in the same way a physical CPU would respond. When 
an event trigger occurs, the STEP 7 program executes the OBs that correspond to the event. 
STEP 7 updates the diagnostic status of the CPU, and the new status is visible in both 
S7-PLCSIM and in the TIA Portal.  

You can access the event table folder from the project tree in Project view.  
 

 Note 

You cannot access event tables from Compact view. 
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Create or open an event table to open the event table editor. The event table editor hosts a 
toolbar and grid for configuring and triggering events. An example event table containing 
four events appears below: 

 
① Event table title bar with the Event table name and icons to Minimize, Float, Maximize, and 

Close the table 
② Event table toolbar with icons to Insert event, Add event, Trigger selected event, and Save 

window settings 
③ Event table columns for Status, Event, Parameter, Trigger, and Comment 
④ Pull or plug of modules event with LADDR and EventType parameters as sub-rows of the event 
⑤ Rack or station failure event with LADDR and EventType parameters as sub-rows of the event 
⑥ Hardware interrupt event with LADDR, IChannel, and EventType parameters as sub-rows of the 

event 
⑦ Diagnostic error interrupt event with LADDR, Module state, and Channels parameters as 

sub-rows of the event. Each of these parameters has additional configurations as sub-rows of 
the parameter. 

⑧ <Add new event> row 
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8.2 Configuring events 

8.2.1 Configuring events 
You can add a new unconfigured event using one of the following methods: 

• Click the <Add new event> cell and select an event type 

• Add or insert a row using the buttons on the toolbar 

You can also change an event you have already configured to another event type. 

8.2.2 Configuring LADDR 
Every event type supported in S7-PLCSIM requires a LADDR parameter. Configuring LADDR is 
the same for all event types.  

Configuring the LADDR parameter 
The LADDR parameter is a 16-bit unsigned decimal integer. 

In the Event Table for your event, select your device from the LADDR parameter drop-down 
list or enter the LADDR parameter as an integer. The integer corresponds to the device's 
Hardware Identifier in TIA Portal. In the TIA Portal, you can find the Hardware Identifier in the 
System Constants of the Properties in the Device Configuration. 

When you rename racks, stations, or modules in TIA Portal and then download, you see 
updated device names in the LADDR parameter. 

8.2.3 Simulating a pull or plug of modules event 
Add an event (Page 86) for the pull or plug of modules event (OB 83) event and configure the 
LADDR parameter (Page 86) and Event type parameter. 

To configure the Event type parameter, select one of the following from the drop-down 
menu:  

• Pull 

• Plug 

• Plug (wrong module) 

When you trigger a pull or plug of modules event, the STEP 7 program calls the OBs 
associated with the event and updates the status of your simulated device. 
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8.2.4 Simulating a rack or station failure event 
Add an event (Page 86) for the rack or station failure (OB 86) event and configure the LADDR 
parameter (Page 86) and Event type parameter. 

To configure the EventType parameter, select one of the following from the drop-down 
menu:  

• Fail 

• Return 

When you trigger a rack or station failure event, the STEP 7 program calls the OBs associated 
with the event. 

8.2.5 Simulating a hardware interrupt event 
Add an event (Page 86) for a hardware interrupt event (OB 4x) event. Configure the LADDR 
parameter (Page 86) and the IChannel and EventType parameters. 

You configure the IChannel parameter as an unsigned 8-bit decimal integer. The range is 0 to 
255. 

You configure the EventType parameter as an unsigned 8-bit integer. The range is 0 to 255. 
EventType is the identifier for the event type that triggers the interrupt, for example, a 
positive edge event. Refer to the documentation for each module for that module's 
EventType identifier values. 

When you trigger a hardware interrupt event, the STEP 7 program calls the OBs associated 
with the event. 

8.2.6 Simulating a diagnostic interrupt event 
Add an event (Page 86) for a diagnostic error interrupt event (OB 82) event. Configure the 
LADDR parameter (Page 86), Module state, and zero or more Channel parameters. 

Configuring module state 
To configure the Module state parameter, select one or more of the following from the 
drop-down menu:  

• Error 

• Maintenance demanded 

• Maintenance required 
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Configuring channels and channel numbers 
To add new channel numbers to the Channel parameter, use one of these options:  

• Type a channel number in the <Add new channel> field 

• Select a channel row and select "Add channel" from the shortcut menu or click the Add 
button on the Event table toolbar. Adding a channel adds the new channel below the 
currently-selected row. 

• Select a channel row and select "Insert channel" from the shortcut menu or click the Insert 
button on the Event table toolbar. Inserting a channel adds the new channel above the 
currently-selected row. 

You are limited to a maximum of 16 channels per Diagnostic error interrupt event. You can 
see all channel numbers as a read-only comma-separated text string in the Channels row.  

You are limited to a maximum of 16 channels per Diagnostic error interrupt event. 

The channel number is a 16-bit unsigned integer. The default channel number is 0 and the 
default display format is decimal. You can enter values in either decimal or hexadecimal 
format (16#xxxx). 

A special case for channel number values is the value 16#8000, which is used to signify a 
diagnostic report for the module itself according to the PROFINET specification. 

Parameters for Channel number include the following: 

Error type is a 16-bit WORD displayed in hexadecimal format.  

Extended error type is a 16-bit WORD displayed in hexadecimal format.  

Severity contains a drop-down list. You can select one of the following:  

• Failure 

• Maintenance demanded 

• Maintenance required 

Direction contains a drop-down list. You can select one of the following:  

• Incoming 

• Outgoing 

When you trigger a Diagnostic interrupt event, the STEP 7 program calls the OBs associated 
with the event and updates the status of your simulated device. 

Deleting channels and channel numbers 
You can delete channels and channel numbers by selecting the row and pressing the delete 
key, or right-clicking and selecting Delete from the shortcut menu. 
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8.3 Triggering events 

Triggering a single event 
To trigger a single event, right-click the event row and select "Trigger event" from the 
shortcut menu.  

Triggering multiple events 
To trigger events in a table, follow these steps:  

1. Select the check box in the trigger column  for each event you want to trigger. For events 
in the table that you do not want to trigger, make sure the trigger check box is not selected 
for those events. 

2. Click the trigger button (lightning bolt icon) on the events toolbar. 

Event triggering errors 
When you attempt to trigger an event that contains syntax errors, such as text in a numeric 
field, S7-PLCSIM does not perform any action for that event.  

If you attempt to trigger an event with invalid parameters, S7-PLCSIM indicates this error with 
a red X icon in the status column. An error message explains the error. 
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 Scan control 9 
9.1 Scan control overview 

S7-PLCSIM enables you to control the scan cycle of your simulated CPU. A scan is defined as 
one complete loop through all program cycle OBs. At startup, the simulated CPU also 
executes startup OBs if they are present. 

You can access scan control features in two ways: 

• In Project view from the Online tools task card 

• In Compact view 

You can use scan control with or without an open project. The requirements for scan control 
are the following: 

• You have downloaded a STEP 7 project. 

• The simulated CPU is powered on. 

9.2 Controlling scans in Project view 

9.2.1 The scan control user interface in Online tools 
The scan control section contains the following items: 

• Displayed operating mode of the CPU 

• A drop-down list that enables you to control a scan using one of the following methods: 

– Continuous scan 

The simulated CPU scans continuously. 

– Pause after running startup OBs 

The simulated CPU executes the startup OBs and then pauses. 

– Specify scan duration 

For this option, you can select a number of scans (Page 91) or units of time (Page 91). 
When you click the Go button, the simulated CPU runs for the number of scans or for 
the specified time. The scan then pauses. 
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9.2.2 Running a scan for a specified time period 
To run a scan for a specified period of time, follow these steps:  

1. Be sure the simulated CPU is powered on. 

2. If the CPU is in RUN mode, set it to STOP or PAUSE. 

3. From the scan control option for controlling the RUN mode transition, select "Specify scan 
duration" 

4. For the scan duration drop-down list, select milliseconds, seconds, or minutes for the time 
base. 

5. Enter a time duration from 1 to 9999. 

6. Click the “Go” button, which has the following effect: 

• The scan runs for the duration you specified. 

• The simulated CPU then pauses. 

You can interrupt a running scan by clicking either the STOP or PAUSE button. Clicking either 
button stops the scan. If you want to resume the scan, click the RUN button. Stopping or 
pausing occurs at the end of a complete scan. S7-PLCSIM runs at least one full scan even if 
you specify only 1 ms for the scan time. 

The status bar at the bottom of the Project view provides feedback on scan control. 

9.2.3 Running a specified number of scans 
To run a specified number of scans, including a single scan, follow these steps:  

1. Be sure the simulated CPU is powered on. 

2. If the CPU is in RUN mode, set it to STOP or PAUSE. 

3. From the scan control option for controlling the RUN mode transition, select "Specify scan 
duration" 

4. From the scan duration drop-down list and text box, select a number of scans to run. You 
can run from 1 to 9999 scans. 

5. Click the “Go” button, which has the following effect: 

• The simulated CPU runs the number of scans that you specified. 

• The simulated CPU then pauses. 

You can interrupt a running scan by clicking either the STOP or PAUSE button. Clicking either 
button stops the scan. Stopping or pausing occurs at the end of a complete scan. 

For a large number of scans, a scan counter shows the number of completed scans. The scan 
counter stops at the number of scans you have chosen to execute. 

The status bar at the bottom of the Project view provides feedback on scan control. 
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9.3 Controlling scans in Compact view 
The following scan controls are available in Compact view: 

• Click the PAUSE button to pause program execution at the end of the currently running 
scan. 

• Click the STOP button to transition to STOP mode. 

• Click the RUN button to restart scanning. 

9.4 Scan control settings for sequences 
From the "Options > Settings" menu command, you can select options for sequence behavior 
under "Scan control":  

• Pause a running sequence when the CPU scan is paused or enters HOLD mode 

• Stop a running sequence when the CPU enters STOP mode 

Paused sequences restart when the CPU scan restarts. You must restart stopped sequences 
manually. 

Breakpoints and scan control 
When the simulated CPU reaches a breakpoint, the scan enters HOLD mode.  

When the simulated CPU is in HOLD mode, scan control features are not available. 
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 Simulating motion control 10 
10.1 Motion control overview 

S7-PLCSIM supports downloading STEP 7 projects that contain motion control elements for 
S7-1500 and ET 200SP CPUs.  

 

 Note 
S7-1200 motion control projects 

S7-PLCSIM does not support motion control for S7-1200 CPUs. 
 

Technology modules and simulation 
S7-PLCSIM simulates a real CPU, but not configured, connected technology modules or other 
I/O devices. 

It is possible to download a project with technology modules for operation of motion control. 
However, the built-in logic of the technology modules is not part of the simulation. 
Therefore, S7-PLCSIM cannot simulate the associated motion control instructions. 

Motion control simulation limitations 
In general, your simulation results might be limited if any of the following are true: 

• Your project uses very short cycle times 

• Your project has a hardware configuration with a large number of devices 

• Your project uses a large number of technology objects 

The behavior of your simulation also depends on the type of technology object(s) you use. 

10.2 Restrictions with motion control 

10.2.1 Simulations and homing mode 
With a real CPU, homing is set directly and the state "reference" correspondingly to it. The 
hardware inputs are not evaluated in simulation. 
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10.2.2 Technology objects not loaded 
If your motion project contains a large number of technology objects, your motion program 
might not download to S7-PLCSIM. 

10.2.3 Maximum of 5,120 motion control resources 
There are motion control resources on each CPU that can be distributed to the technology 
objects. S7-PLCSIM supports a maximum of 5,120 motion control resources. 

Exceeding the quantity structure 
When you load a project into a CPU, STEP 7 checks whether the quantity structure for a 
configured CPU is correct. An alert message displays if the quantity structure is exceeded. 

A project that uses more than 5,120 motion control resources can be downloaded to a virtual 
controller. However, there is no message indicating that the quantity structure has been 
exceeded. 

After your program accesses the technology objects, you can observe the following 
indications if the quantity structure has been exceeded: 

• An error message at the block 

• A value of zero for the object 

10.2.4 Wait briefly after going to RUN mode to access motion control technology 
objects 

The simulated PLC processes motion control commands more slowly than a physical PLC. 
Because of this difference in processing time, you might encounter an "error" or "busy" state if 
you attempt to access motion control objects too quickly after going to RUN mode. This is 
because the objects might not have finished processing completely.  

To avoid the situation, wait briefly to access motion control objects after you put the PLC in 
RUN mode. 

For further details about motion control, see the help section "Differences common to all 
supported PLCs" > "Simulating motion control". 

10.2.5 Motion OB overruns 
An overload occurs when events which originate from the same source occur faster than they 
can be processed. S7-PLCSIM does not process motion OB overruns. 
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10.2.6 Upgraded projects containing MC-Servo (OB91) and MC-Interpolator (OB92) 
blocks 

You cannot load a motion control project that contains the blocks MC-Servo (OB91) and 
MC-Interpolator (OB92) to S7-PLCSIM. 

To enable simulation, delete these blocks and then recompile your project. When you 
recompile, the properties of blocks OB91 and OB92 reset to the default values. You will then 
be able to load your motion control project to S7-PLCSIM. 

10.2.7 Simulation deactivates MC-PreServo and MC-PostServo 
S7-PLCSIM does not simulate the operations of the motion OBs MC-PreServo and MC-
PostServo. 

10.2.8 TO_PositioningAxis 
With the TO_PositioningAxis technology object, the simulated drive provides feedback 
regarding position functions to S7-PLCSIM.  

Axis position feedback 
The setpoint (position) is integrated with a certain time delay (PT1 element). The result of this 
calculation is fed back to the TO_PositioningAxis object as the actual position of the axis. 

Homing axis 
If you have selected the homing mode "Use zero mark via PROFIdrive telegram" in STEP 7, 
S7-PLCSIM responds immediately to every active (Mode 2, 3, 8) or passive (Mode 4, 5) 
homing command (MC_Home) with the actual position being set as the home position.  

Simulation restrictions 
• S7-PLCSIM does not simulate an analog positioning axis. 

• With Dynamic Servo Control (DSC) telegram 5, you might need to adjust the STEP 7 
settings under "Control loop: Precontrol and velocity gain (Kv factor)" and/or under 
"Positioning monitoring > Following error" to obtain meaningful simulation behavior. 
Adjust these settings incrementally until your simulation responds as expected. 

10.2.9 TO_ExternalEncoder 
With the TO_ExternalEncoder technology object, the simulated external encoder provides 
static/fixed position feedback, which is set by homing commands, to S7-PLCSIM.  
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Homing 
Active homing is not possible with the TO_ExternalEncoder object. 

If you have selected the passive homing mode "Use zero mark via PROFIdrive telegram" in 
STEP 7, S7-PLCSIM responds immediately to every passive (Mode 4, 5) homing command 
(MC_Home) with the actual position being set as the home position. 

10.2.10 High Speed Counter 
S7-PLCSIM does not support simulation for the High_Speed_Counter technology object for 
S7-1500 compact CPUs. 

10.2.11 High Speed Counter functionality for S7-1500C (compact) PLCs 
S7-PLCSIM supports simulation for the S7-1500 compact controllers (S7-15xxC). 

However, it is not possible to simulate the onboard high speed counters (HSC) or pulse 
generators (PTO/PWM).  Programs that rely on this functionality might not behave realistically 
during simulation. 

10.2.12 Isochronous mode not possible error 
Under some motion control scenarios, you might receive an error message that isochronous 
mode is not possible. 

Example scenario 

The TO OutputCam is configured with TM Timer DIDQ in a distributed ET 200SP high feature 
interface module. 

Observation 

When TO is activated with MC-OutputCamEnable, Alarm Number 113 displays a message that 
isochronous mode is not possible. 

Solution 

• The configured output for the cam or cam track technology object or the input for the 
technology object measuring input cannot be used in isochronous mode. Configure the 
I/O in the device configuration as isochronous I/O. 

• Make sure that the organization block MC_Servo [OB91] is called synchronously with the 
bus system. 
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 Simulating communication 11 
 

 

S7-PLCSIM supports communication between simulation instances. An instance can be an 
S7-PLCSIM simulation, a WinCC runtime simulation, or an S7-PLCSIM V5.4.8 simulation. 

You can run two S7-PLCSIM simulations, up to eight instances of S7-PLCSIM V5.4.8, and an 
even larger number of WinCC runtime simulations, and they can communicate with each 
other. 

For simulation instances to communicate with each other, observe these requirements: 

• The simulation instances must run on the same programming device. 

• The CPUs in the separate simulation instances must have unique IP addresses. 

Supported connections 
S7-PLCSIM supports TCP/IP connections. 

If you want to simulate communication using a TCP connection, you must use a TCON 
instruction to set up and establish the communication connection. S7-PLCSIM does not 
recognize a TCP connection that is established in the TIA Portal "Devices & networks" section.  

IP addresses and communication 
You cannot run multiple simulations if the simulated PLCs have the same IP address. Each 
simulated PLC must have a unique IP address. 

T-Block instructions and data buffering 
S7-PLCSIM implements T-Block instructions without data buffering on the receiving CPU. 

The simulated sending CPU's TSEND instruction does not complete until the program on the 
simulated receiving CPU executes the TRCV instruction. 

T-block instructions and 1024 byte limitation 
The maximum number of data bytes that can be received at a time is 1024. 
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 Error conditions and limitations 12 
 

 

Specific actions or events might result in errors or unexpected behavior in S7-PLCSIM or in 
STEP 7. A description of each known issue and any workarounds follow.  

12.1 S7-1200 Fail-Safe simulation 
To use S7-PLCSIM to simulate an S7-1200 Fail-Safe CPU, you must use a safety system version 
that is compatible with the CPU firmware version: 
 
S7-1200 Fail-safe CPU firmware version System Safety version 
V4.2 or below V2.1 or below 
V4.3 or above Any version 

To modify the system safety version, follow these steps in STEP 7: 

1. Open the Safety Administration dialog for the CPU. 

2. Click "Settings" and select an appropriate system safety version from the drop-down list. 

12.2 Value status defaults 
The default value status differs between Fail-safe I/O devices and non-Fail-safe (standard) I/O 
devices as follows: 

• Fail-safe I/O device value status defaults to "1", ON, or TRUE 

• Standard I/O device value status defaults to "0", OFF, or FALSE 

You can modify the reported value status by using SIM tables and sequences. 

12.3 SIM table recording might generate invalid sequences 
It is possible to modify process values without tags in the SIM table. However, sequences 
require tags for most process values. 

To avoid possible errors when you use the SIM table "record sequence" function, define tags 
for the relevant addresses, or avoid such operations when you record a sequence. 

12.4 High feature module support 
For physical CPUs, high feature (HF) modules can provide advanced functions for additional 
requirements. 
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S7-PLCSIM does not support simulation of any of these advanced functions. For example, 
high feature power modules do not provide additional retentive memory for simulations. 

12.5 HMI type-safe array element display 
HMI tags for type-safe array elements might display as “####”. This display can be avoided in 
one of the following ways: 

• Do not use arrays in HMI tags. Use single elements only.

• Adjust the maximum acquisition time of the HMI tag to a higher value (such as 10
seconds) to allow the tag to display correctly.

12.6 Saving S7-1500 retentive data block (DB) values 
Retentive data block values for an S7-1500 PLC might not be saved unless you power off the 
PLC before you save the project. 

S7-1200 projects do not experience this behavior. 

12.7 Yellow coloring for fail-safe I/O 
S7-PLCSIM might not display I/O addresses for fail-safe devices with yellow coloring. Be aware 
that this might happen when you simulate fail-safe applications. 

12.8 Scan cycle overflow 
The S7-PLCSIM cyclic event queue can overflow when your simulation contains cyclic 
interrupts. Due to the speed of S7-PLCSIM in relation to the speed of actual hardware, your 
simulation might not be able to process cyclic OBs within the cycle time you specified. 
S7-PLCSIM provides visual notification of an overflow by means of diagnostic buffer messages 
and a red error icon in the project tree. 

If the main scan cycle overflows, follow these steps: 

1. Select the Options > Settings menu command.

2. Select the "Cycle time monitoring" settings.

3. You can then take one of the following actions:

– Select "Disable scan cycle monitoring".

– Select "Specify maximum cycle time" and then increase the value in the "Maximum
cycle time" box.

If a cyclic interrupt OB overflows, increase the cyclic time for the OB in STEP 7. 

After taking any of these actions, you must download from STEP 7 for the change to take 
effect. 
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12.9 Incompatible diagnostic status for simulated S7-1500 PLCs with 
firmware version 1.8 

When you simulate an S7-1500 PLC with firmware version 1.8, S7-PLCSIM might display the 
diagnostic status "Incompatible". You can ignore this status message because your simulation 
will function normally. 

12.10 Simulating HMI connections 
When you simulate HMI connections, the simulated HMI firmware version must be 14.0.0.0 
or higher. 

12.11 HMI Accessible tags 
STEP 7 sets tags to "Accessible from HMI" by default. In the following example, a user has 
removed HMI accessibility for the tags "Static_3" and "Static_4":  

 

After you download from STEP 7 to S7-PLCSIM, the tags "Static_3" and "Static_4" are not 
available in S7-PLCSIM: 

 
To work with these tags in S7-PLCSIM, you must select HMI accessibility for the tags in STEP 7 
and download the changes to S7-PLCSIM. 
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12.12 Compile error after attempting to download to S7-PLCSIM 
When you attempt to download a STEP 7 program to S7-PLCSIM, you might receive an error 
that the user program was not compiled and that you should compile the program again. 

You might encounter this scenario under one of these conditions: 

• When you simulate a program that was uploaded from a physical PLC 

• When you simulate a program that was copied and pasted into your project 

This error is related to automatically generated program blocks such as MC-Servo and MC-
Interpolator OBs in motion control programs.  

To resolve the error, delete the automatically generated blocks and then compile the program 
again by using the command "Compile > Software (rebuild all blocks)". This command will 
correctly recreate and compile the blocks for use in S7-PLCSIM. However, before deleting the 
blocks, check the settings in your OBs. 

Be aware that this error is not limited to motion control. Any program that contains 
automatically generated blocks might experience the issue. After you remove the 
automatically generated blocks, your program should compile and download to S7-PLCSIM 
without further error. 

12.13 "Cut" performs a "Copy" between S7-PLCSIM instances 
When you perform a cut and paste operation between two open instances of S7-PLCSIM, the 
data from the source instance is copied instead of being cut. 

Description of behavior 
Start two instances of S7-PLCSIM and create a simulation project in both instances. 

Enter addresses into a SIM table or sequence in one of the instances. 

Cut one, or several, of the rows from one instance and paste them into a SIM table or 
sequence in the other instance. 

Observe that the cut items from the source instance are copied instead of being cut or 
removed. The cut items appear in the target instance as expected but remain in the source 
instance. 

Solution 
To work around this behavior, delete the cut rows from the source instance after you have 
pasted them into the target instance. 

12.14 Simulating communication with an HMI and multiple PLCs 
If you want to simulate multiple PLCs with an HMI, you might encounter unexpected 
connection behavior due to the way S7-PLCSIM simulates communication. 
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You can prevent the problem by starting all PLC simulations before launching your HMI. 

Note 

If you have started your HMI before starting all PLC simulations and then notice unexpected 
behavior, close and restart the HMI while the PLC simulations remain active. 

12.15 Simulating fail-safe programs 
Because of differences in cycle times between the simulated PLC and a physical PLC, your 
fail-safe program might go to STOP unexpectedly. 

To correct the situation, increase the F parameter value in STEP 7 by following these steps: 

1. In the inspector window, go to "General > Fail Safe > F parameter" and set the "Default F
monitoring time for central F I/O" to its maximum allowable time (65535 ms).

2. Download from STEP 7 and then run your simulation again.

12.16 Use STEP 7 safety system library V1.3 or later for Fail-Safe I/O 
To successfully simulate and debug a project that contains Fail-Safe I/O, your project must use 
safety system library V1.3 or later. If your project uses an older version of this system library, 
your Fail-Safe I/O simulation will not function correctly. 

12.17 Working with global libraries 
If your project uses a library, you must compile both hardware and software before 
performing a download to S7-PLCSIM. If you perform only a partial compile, your download 
will fail.  

12.18 Incorrect RET_VAL parameter values for S7-1500 EN_AIRT and 
DIS_AIRT instructions that are called from multiple OBs 

The extended interrupt instructions EN_AIRT and DIS_AIRT function correctly for S7-1500 
projects if they are called from the same OB. 

These instructions do not function correctly if they are called from more than one OB. If they 
are called from more than one OB, the RET_VAL parameter value might not be correct.  
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12.19 HMI password protection levels and simulation 
You cannot configure a PLC protection password in your HMI and then download to 
S7-PLCSIM.  

If you attempt to run a simulation with protection levels set, the HMI receives an error and is 
unable to connect to S7-PLCSIM. S7-PLCSIM does not check protection levels and therefore 
indicates that no password is set.  

If you have already set protection levels for your PLC, you must remove them before running 
a simulation. After you are finished with your simulation, you can restore your protection 
levels. 

12.20 STEP 7 online & diagnostics functions 
STEP 7 online & diagnostics functions 

Certain online & diagnostics functions do not serve a useful purpose for simulation. Using 
them might cause unexpected behavior in S7-PLCSIM. These include:  

• Assign IP address

• Format memory card

• Assign name

• Firmware update

12.21 Simulation during standby mode 
Simulation might stop when your computer or programming device enters "standby" or 
"sleep" mode. If this happens, communication between STEP 7 and S7-PLCSIM is suspended. 

When your computer or programming device becomes active again, it might be necessary to 
reestablish communication, or in some cases, to reopen your simulation project.  

To prevent this situation, disable standby mode for your computer or programming device. 

12.22 Working with automatically synchronized network drives 
If you store a project that is automatically synchronized on a network drive or in a cloud 
directory (with Dropbox, Syncplicity or Google Drive, for example), this can lead to data loss if 
the synchronization takes place only partially or asynchronously. Therefore, storing and 
editing projects directly on synchronized network drives or cloud directories is not 
recommended. 

If you must use synchronization, make sure that it is implemented in such a way that the 
current (local) project data replaces the project data on the network drive or in the cloud 
directory. 

Always close your projects before synchronization, and then make sure that all project 
directory files are synchronized together and completely. 
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12.23 Project menu delay 
You might experience delays, and possibly a crash, when you are opening the project menu if 
a project in the most recently used projects list is located on a network drive that is not 
connected.  

To correct the problem, reconnect the network drive, or move your projects folder to a 
connected drive. 

12.24 Mnemonics selection 
Entering values with commas as decimal places (for example, "1,23") might lead to an error 
with some Windows language settings.  

Use the international format with a period as the decimal place (for example, "1.23"). 

12.25 Modbus V5.2 not supported 
S7-PLCSIM does not support Modbus V5.2 but does support other versions of Modbus. 

12.26 Error returned by High_Speed_Counter instruction 
If you use S7-PLCSIM to simulate a high speed counter in a TM Count module, the 
High_Speed_Counter instruction returns the error 16#80C7. 

The High_Speed_Counter instruction expects that the module has set a status ready 
(STS_READY) bit. Because S7-PLCSIM does not simulate module behavior, the instruction 
returns an error. 

The STS_READY bit is in the input area of the module at offset 13.4. If the input area of your 
TM Count module begins at %I32, for example, then the STS_READY bit is at %I45.4. 

You can set the STS_READY bit to avoid the error condition that the High_Speed_Counter 
instruction returns. 

Setting STS_READY from a SIM table 
Consider an example using an S7-1500 with a TM Count 1x24V module where the TM Count 
1x24V begins at %I.0. Note that you can find this address in the device configuration for your 
technology module. 

To set the STS_READY bit for the module to TRUE, enter the corresponding I address for offset 
13.4 in your SIM table. Set the modify value to TRUE. For example, if your module begins at 
%I0, configure a SIM table entry as follows: 
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12.27 T_CONFIG instruction 
The T_CONFIG instruction performs no action in S7-PLCSIM. 

12.28 Simulating the Drive controller 
S7-PLCSIM simulates only the standard CPU functionality of the SIMATIC Drive Controller. 

S7-PLCSIM does not simulate the following: 

• Technology functions of the onboard I/O 

• SINAMICS Integrated 

• PROFINET IO 

• PROFIBUS DP 

You can only simulate the integrated inputs/outputs of the X122, X132 and X142 interfaces 
as binary inputs/outputs. 
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Configuring LADDR, 86 
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Control view, SIM table, 59 

Copy protection, 18 

Counting and measurement technology modules and 
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ET 200SP, 21 

S7-1500, 20 

Counting technology modules, S7-1200, S7-1200 

Subentry, 20 

CPU family 

Compact view, 27 

Project view, operator panel, 38 

CPU operator panel, 38 

CPU power on and off, 38 

Cycle time settings, 42 

D
Data buffering, 97 

Debugging projects, 24 

Diagnostic error interrupt event, 88 

Diagnostic errors, 18 

Duplicate addresses in sequence, 82 

E
Edit menu, 34 

Editor bar, 33 

Editor functions, 47 

Empty address field in imported file, 56, 61 

Ending a simulation, 16 

Error indicator, 49 
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Errors in a sequence, 82 

ET 200SP: technology modules and objects, 

Event simulation, 84 

configuring LADDR, 86 

diagnostic error interrupt, 87 

hardware interrupt, 87 

pull or plug of modules, 86 

rack or station failure, 87 

Event tables 

project tree, 40 

EventType parameter 

hardware interrupt, 87 

rack or station failure event, 87 

Execute menu, 35 

Execution 

editing time, 78 

Execution time of a sequence, 64 

Exporting 

sequences, 70 

SIM tables, 55 

Exporting a sequence to Excel, 64 

F
Fail-Safe device simulation 

yellow coloring, 99 

Fail-Safe indicator, 49 

Features, 9 

Firmware versions of CPUs, 11 

Force indicator, 49 

Force table as SIM table, 57 

Forced address, 50, 62 

G
Global libraries, 102 

H
Hardware requirements, 10 

Hardware support package (HSP), 11 

Help system, 12, 37 

HMI Accessible tags, 100 

HMI connections, 100 

HOLD mode, 66 

I
I/O 

addresses, 48 

device support, 18 

IChannel parameter (Hardware interrupt), 87 

Import only partially successful, 56, 61 

Importing 

sequences, 70 

SIM tables, 55 

Importing a sequence 

from a trace measurement, 64 

from Excel, 64 

Incompatible data type in sequence, 82 

Incompatible status display, 100 

Incorrect parameter values, 102 

Information system, 12 

Inserting a step in a sequence, 63 

Installation, 10 

Installed software, 37 

Interrupt events 

LADDR parameter, 86 

simulating, 84 

Invalid address in sequence, 82 

IP address, 38 

IP addresses and communication, 97 
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Keyboard shortcuts, 43 

L
LADDR, 86 

Language settings, 40 

LEDs, 18 

M
Main menu, 33 

Edit, 34 

Execute, 35 

Help functions, 37 

help system, 37 

Options > Settings, 35 

Project, 34 

window commands, 36 

Maximum cycle time, 42 

MC-Interpolator, 95

MC-Servo, 95

Memory addresses, 48

Memory reset, 28

Menu bar, 33

Mnemonic setting, 40

Mnemonics selection, 104

Motion control, 93

alarm 113, 96 

errors from technology objects, 94 

homing mode, 93 

isochronous mode error, 96 

limitations, 93 

loading project with MC-Servo and MC-
Interpolator, 95 

maximum resources, 94 

quantity structure, 94 

technology objects, 93 

TO_ExternalEncoder, 95 

TO_PositioningAxis, 95 

Motion Control 

technology modules and objects, ET 200SP, 20 

technology modules and objects, S7-1500, 20 

technology modules, S7-1200, 20 

MRES, 28 

Multiple event triggers, 89 

Multiple instances 

copy and paste, 101 

N
Network drives, 103 

New features, 9 

O
Online support, 13 

Online/offline status, 46 

Open controllers, 18 

Opening projects from older versions, 24 

Operator panel, 38 

P
Password protection levels 

simulation, 103 

Pasting structured tags, 47 

PAUSE button 

Compact view, 31 

Project view operator panel, 38 

PID Control technology modules and objects 

ET 200SP, 20 

S7-1500, 20 

PID Control technology modules, S7-1200, 20 

Pinning the editor screen, 33 
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Playing a sequence created from recorded SIM table 
actions, 69 

PLC tag table as SIM table, 57 

Power button, 16 

Prerequisites to startup, 22 

Program debugging, 62 

Project 

opening, 23 

storage location, 42 

versions, 24 

Project menu, 34 

delay, 104 

Project tree, 39 

Project view 

input values, 9 

overview, 15 

toolbar, 37 

user interface, 32 

Projects, 44 

Purpose of S7-PLCSIM, 9 

Push button control for Boolean values, 61 

Push button, SIM table Control view, 61 

R
Rack or station failure, 87 

Readme file, 13 

Recent project list, 40 

Recipes, 18 

Recording actions 

from a SIM table, 58 

to create a sequence, 68 

Redo, 45 

Resetting to default settings, 41 

RUN mode, 35 

Compact view, 31 

Project view operator panel, 38 

setting from Execute menu, 35 

Running a specified number of scans, 91 

S
S7-1200 

Fail-Safe, 19 

supported instructions, 19 

technology modules and objects, 20 

S7-1200F 

F-monitoring time, 19

supported instructions, 19

S7-1500 

technology modules and objects, 20 

S7-300 and S7-400 simulation, 10 

S7-ET 200SP 

PID technology object, 21 

S7-PLCSIM Advanced, 10 

S7-PLCSIM overview, 9 

S7-PLCSIM V5.4.8 

communication between simulation instances, 97 

Scan control 

breakpoints, 92 

in Compact view, 92 

overview, 90 

run for specified time period, 91 

running a specified number of scans, 91 

user interface, 90 

Scan cycle overflow, 99 

SD memory card, 18 

Sequence 

auto fill and default interval, 68 

breakpoints and HOLD mode, 67 

creating and populating, 68 

creating from imported trace file, 71 
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delaying steps, 82 

editable steps, 65 

enable and disable steps, 81 

importing and exporting, 70 

project tree, 39 

repeating from the toolbar button, 74 

running multiple, 63 

starting a sequence, 72 

trigger condition, 73 

visual feedback, 75 

watch table entries, 70 

Sequence editor 

actions, 75 

addresses, 62 

default interval, 80 

error conditions, 82 

execution time, 78 

overview, 62 

Set to frequency, 76 

Set to value, 76 

step timing, 78 

time values, 76 

undo and redo, 67 

user interface, 63 

working with steps, 80 

Service and support, 13 

Set to frequency, 76 

Set to value, 76 

Settings 

cycle time, 42 

storage, 42 

Setup, 10 

Shortcut keys, 43 

SIM table 

Bits column, 55 

creating from STEP 7 tables, 57 

error conditions, 61 

importing and exporting, 55 

load project tags, 54 

monitoring and modifying values, 54 

overview, 50 

project tree, 39 

recording actions, 68, 69 

slider control for updating values, 59 

ways to create and populate, 53 

SIM table editor, 50 

autofill, 56 

recording actions to create sequence, 58 

table and control views, 59 

Simulating 

communication, 97 

communication with an HMI and multiple PLCs, 102 

diagnostic error interrupt, 87 

hardware interrupt, 87 

HMI connections, 100 

power cycle, 26 

pull or plug of modules, 86 

rack or station failure, 87 

S7-300s and S7-400s, 10 

Simulating 

motion control in run mode, 94 

Simulation 

errors, 98 

standby mode problems, 103 

support in STEP 7, 22 

Slider control, SIM table values, 59 

Software controllers, 18 

Splitting the screen, 33 

Start CPU, 35 

Start view, 41 
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Starting a sequence, 65 

Starting a simulation, 16 

Starting S7-PLCSIM 

from an existing project, 23 

from TIA Portal, 22 

from Windows desktop, 23 

Startup options, 22 

Status bar with progress display, 33 

Status LEDs, 38 

STEP 7 

exporting a trace file, 71 

licenses, 11 

online & diagnostics functions, 103 

pasting into S7-PLCSIM, 47 

Stop CPU, 35 

STOP mode 

Compact view, 31 

Project view operator panel, 38 

setting from Execute menu, 35 

Stop sequence time error, 82 

Storage location for projects, 44 

Storage of projects, 42 

Structured tags 

importing, 70 

pasting into editors, 47 

Supported operating systems, 10 

Supported STEP 7 programs, 17 

Switching between views, 15 

T
Tags 

auto-completion, 49 

tag names, 48 

T-Block instructions, 97

Technology modules, 93 

Time entry for sequences, 76 

Time-based I/O technology modules 

ET 200SP, 20 

S7-1500, 20 

Title bar, 32 

Toolbar, 32 

Project view, 37 

record/playback commands, 36 

sequence editor, 63 

Tools menu, 36 

Tooltip cascades, 40 

Triggering events, 89 

U
Unconfigured simulation, 17 

Undefined error in sequence, 82 

Undo, 45 

Unpinning the editor screen, 33 

Updating 

Boolean values with push button, 61 

numeric values with slider control, 59 

User interface 

Project view, 32 

split windows, 37 

User name, 40 

Using the STEP 7 safety system library, 102 

V
Views 

Compact view, 30 

default view, 41 

project view, 32 

W
Watch table as SIM table, 57 
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Web server, 18 

What's new, 9 

WinCC runtime simulation, 97 

Window menu commands, 38 
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